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1. INTRODUCTION

The RCM3200 RabbitCore™ module is designed to be the heart
of embedded control systems. The RCM3200 features an inte-
grated 10/100Base-T Ethernet port and provides for LAN and
Internet-enabled systems to be built as easily as serial-communi-
cation systems.

Throughout this manual, the term RCM3200 refers to the complete series of RCM3200
RabbitCore modules unless other production models are referred to specifically.

The RCM3200 has a Rabbit 3000® microprocessor operating at 44.2 MHz, data and pro-
gram execution SRAM, flash memory, two clocks (main oscillator and timekeeping), and
the circuitry necessary for reset and management of battery backup of the Rabbit 3000°s
internal real-time clock and the data SRAM. Two 34-pin headers bring out the Rabbit
3000 I/0 bus lines, parallel ports, and serial ports.

The RCM3200 receives its +3.3 V power from the customer-supplied motherboard on
which it is mounted. The RabbitCore RCM3200 can interface with all kinds of CMOS-
compatible digital devices through the motherboard.

1.1 RCM3200 Features

e Small size: 1.85" x 2.65" x 0.86"
(47 mm x 67 mm x 22 mm)

e Microprocessor: Rabbit 3000 running at 44.2 MHz

e 52 parallel 5V tolerant I/O lines: 44 configurable for 1/0, 4 fixed inputs, 4 fixed outputs
e Two additional digital inputs, two additional digital outputs

e External reset input

o Alternate 1/0O bus can be configured for 8 data lines and 6 address lines (shared with
parallel 1/O lines), 1/O read/write

e Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers
e 512K flash memory, 512K program execution SRAM, 256K data SRAM

e Real-time clock
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Watchdog supervisor

Provision for customer-supplied backup battery via connections on header J2
10/100Base-T RJ-45 Ethernet port

10-bit free-running PWM counter and four width registers

Two-channel Input Capture can be used to time input signals from various port pins

Two-channel Quadrature Decoder accepts inputs from external incremental encoder
modules

Six CMOS-compatible serial ports: maximum asynchronous baud rate of 5.5 Mbps. Four
ports are configurable as a clocked serial port (SP1), and two ports are configurable as
SDLC/HDLC serial ports.

Supports 1.15 Mbps IrDA transceiver

Appendix A, “RCM3200 Specifications,” provides detailed specifications for the
RCM3200.

1.2 Advantages of the RCM3200

Fast time to market using a fully engineered, “ready to run” microprocessor core.

Competitive pricing when compared with the alternative of purchasing and assembling
individual components.

Easy C-language program development and debugging

Program Download Utility and cloning board options for rapid production loading of
programs.

Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.

Integrated Ethernet port for network connectivity, royalty-free TCP/IP software.

1.3 Development and Evaluation Tools

A complete Development Kit, including a Prototyping Board and Dynamic C develop-
ment software, is available for the RCM3200. The Development Kit puts together the
essentials you need to design an embedded microprocessor-based system rapidly and effi-
ciently.

See the RabbitCore RCM3200 Getting Started Manual for complete information on the
Development Kit.
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1.4 How to Use This Manual

This user’s manual is intended to give users detailed information on the RCM3200 mod-
ule. 1t does not contain detailed information on the Dynamic C development environment
or the TCP/IP software support for the integrated Ethernet port. Most users will want more
detailed information on some or all of these topics in order to put the RCM3200 module to
effective use.

1.4.1 Additional Product Information

Introductory information about the RCM3200 and its associated Development Kit and
Prototyping Board will be found in the printed RabbitCore RCM3200 Getting Started
Manual, which is also provided on the accompanying CD-ROM in both HTML and
Adobe PDF format.

We recommend that any users unfamiliar with Z-World products, or those who will be
using the Prototyping Board for initial evaluation and development, begin with at least a
read-through of the Getting Started manual.

In addition to the product-specific information contained in the RabbitCore RCM3200
Getting Started Manual and the RabbitCore RCM3200 User’s Manual (this manual),
several higher level reference manuals are provided in HTML and PDF form on the
accompanying CD-ROM. Advanced users will find these references valuable in develop-
ing systems based on the RCM3200 modules:

Dynamic C User’s Manual

Dynamic C Function Reference Manual
An Introduction to TCP/IP
Dynamic C TCP/IP User’s Manual

Rabbit 3000 Microprocessor User’s Manual

1.4.2 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, use your browser to find and load default.htm in the docs
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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2. HARDWARE SETUP

This chapter describes the RCM3200 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: This chapter (and this manual) assume that you have the RCM3200 Development
Kit. If you purchased an RCM3200 module by itself, you will have to adapt the infor-
mation in this chapter and elsewhere to your test and development setup.

2.1 Development Kit Contents

The RCM3200 Development Kit contains the following items:

RCM3200 module.
Prototyping Board.

AC adapter, 12 V DC, 1 A. (Included only with Development Kits sold for the North
American market. A header plug leading to bare leads is provided to allow overseas
users to connect their own power supply with a DC output of 8-24 V at 8 W.)

10-pin header to DE9 programming cable with integrated level-matching circuitry.
Dynamic C CD-ROM, with complete product documentation on disk.

This Getting Started manual.

A bag of accessory parts for use on the Prototyping Board.

Registration card.
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2.2 Development Hardware Connections

There are four steps to connecting the Prototyping Board for use with Dynamic C and the sam-
ple programs:

1. Attach the RCM3200 module to the Prototyping Board.

2. Connect the programming cable between the RCM3200 module and the workstation PC.

3. Connect the module’s Ethernet port to a PC’s Ethernet port, or to an Ethernet network.

4. Connect the power supply to the Prototyping Board.

2.2.1 Attach Module to Prototyping Board

Turn the RCM3200 module so that the Ethernet connector end of the module extends off the
Prototyping Board, as shown in Figure 1 below. Align the pins from headers J1 and J2 on the
bottom side of the module into header sockets RCM2JA and RCM2JB on the Prototyping

Board (these sockets were labeled J12 and J13 on earlier versions of the Prototyping Board).

RCM3200 |E:
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Figure 1. Installing the RCM3200 Module on the Prototyping Board

Although you can install a single module into either the MASTER or the SLAVE position
on the Prototyping Board, all the Prototyping Board features (switches, LEDs, serial port
drivers, etc.) are connected to the MASTER position. We recommend you install a single
module in the MASTER position.

NOTE: Itisimportant that you line up the pins on headers J1 and J2 of the RCM3200
module exactly with the corresponding pins of header sockets RCM2JA and RCM2JB
on the Prototyping Board. The header pins may become bent or damaged if the pin
alignment is offset, and the module will not work. Permanent electrical damage to the
module may also result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board header sockets.
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2.2.2 Connect Programming Cable

The programming cable connects the RCM3200 to the PC running Dynamic C to down-
load programs and to monitor the RCM3200 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on
the RCM3200 module as shown in Figure 2. Be sure to orient the marked (usually red)
edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector, which is
used for a normal serial connection.)

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this
Development Kit—the programming cable has blue shrink wrap around the RS-232 con-
verter section located in the middle of the cable. Programming cables from other Z-World
or Rabbit Semiconductor kits were not designed to work with RCM3200 modules.
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Figure 2. Connect Programming Cable to RCM3200

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use
an RS-232/USB converter with the programming cable supplied with your RabbitCore
module. An RS-232/USB converter is available through the Z-World Web store.
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2.2.3 Connect Power

When all other connections have been made, you can connect power to the Prototyping
Board.

Connect the wall transformer to jack J11 on the Prototyping Board as shown in Figure 3
below.

3-pin
power connector

000000000000 OOOOOOOOOOOO0O0
000000000000 0O0O0O0O0OO0OO0OOO0O00OOJ
< 000000000000 0O0O0O0O0OO0OO0OOO0O0OOOJ
- 000000000000 000O0O00O00O0OOO0O0OOOJ

000000000000 00O0O00O000000O0OOO00O0O000
000000000000 000O0O000000O0O00O00O0O00O0
00000000000 000O0O00O0000O0OO0O0OO00O0O000
000000000000 000O00O0000OO0OO0O00O00O000O0
OOOOOOOI

RCM30/31/32XX SERIES
PROTOTYPING BOARD

uuuuuuuuuuuuu

Figure 3. Power Supply Connections

Plug in the wall transformer. The power LED on the Prototyping Board should light up.
The RCM3200 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow hardware reset
without disconnecting power.

To power down the Prototyping Board, unplug the power connector from J11. You should
disconnect power before making any circuit adjustments in the prototyping area, changing
any connections to the board, or removing the RCM3200 from the Prototyping Board.

2.2.3.1 Overseas Development Kits

Development kits sold outside North America include a header connector that may be
connected to 3-pin header J9 on the Prototyping Board. The connector may be attached
either way as long as it is not offset to one side. The red and black wires from the connec-
tor can then be connected to the positive and negative connections on your power supply.
The power supply should deliver 8 V-24 V DC at 8 W.
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2.3 Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming
connections by running a sample program.

The RCM3200 runs at 44.2 MHz, and has a fast program execution SRAM to ensure that
the memory where any programs run can handle the higher clock speed. In order to run
Dynamic C applications in the fast SRAM, you will need to set the compiler to run the
application in the program execution SRAM by selecting Code and BIOS in Flash, Run
in RAM from the Dynamic C Options > Project Options > Compiler menu.

Find the file PoNG. ¢, which is in the Dynamic C sampLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open and will dis-
play a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in
Section 5.5, “Run the PINGME.C Sample Program,” tests the TCP/IP portion of the board.

2.3.1 Troubleshooting

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load the sample program, it is possible that
your PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Choose a lower debug baud rate.

If there are any other problems:

e Check to make sure you are using the PROG connector, not the DIAG connector, on
the programming cable.

e Check both ends of the programming cable to ensure that they are firmly plugged into
the PC and the programming port on the RCM3200.

e Ensure that the RCM3200 module is firmly and correctly installed in its connectors on
the Prototyping Board.

e Select a different COM port within Dynamic C. From the Options menu, select
Project Options, then select Communications. Select another COM port from the
list, then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If
Dynamic C still reports it is unable to locate the target system, repeat the above steps until
you locate the active COM port.
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2.4 Where Do | Go From Here?

We recommend that you proceed to the next chapter and install Dynamic C (if you do not
already have it installed), then run the ponG. ¢ sample program to verify that the
RCM3200 module and the Prototyping Board are set up and functioning correctly.

If everything appears to be working, we recommend the following sequence of action:

1. Run all of the sample programs described in the RCM3200 Getting Started Manual to
get a basic familiarity with Dynamic C and the RCM3200 module’s capabilities.

2. For further development, refer to the RabbitCore RCM3200 User’s Manual for details
of the module’s hardware and software components.

A documentation icon should have been installed on your workstation’s desktop; click
on it to reach the documentation menu. You can create a new desktop icon that points to
default.htm in the docs folder in the Dynamic C installation folder.

3. For advanced development topics, refer to the Dynamic C User’s Manual and the
Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.4.1 Technical Support

NOTE: If you purchased your RCM3200 through a distributor or through a Z-World or
Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at
www.zworld.com/support/bb/.

e Use the Technical Support e-mail form at www.zworld.com/support/questionSubmit.shtml.
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3. HARDWARE REFERENCE

Chapter 3 describes the hardware components and principal hardware
subsystems of the RCM3200. Appendix A, “RCM3200 Specifica-
tions,” provides complete physical and electrical specifications.

Figure 4 shows these Rabbit-based subsystems designed into the RCM3200.

32 kHz | [22.1 MHz
osC osC
SRAM RABBIT logic-level serial signal
3000
Flash
Level
converter
Ethernet
RS-232, RS-485, IRDA
serial communication
RabbitCore Module drivers on motherboard

Figure 4. RCM3200 Subsystems
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3.1 RCM3200 Digital Inputs and Outputs

The RCM3200 has 52 parallel 1/0 lines grouped in seven 8-bit ports available on headers
J1 and J2. The 44 bidirectional 1/O lines are located on pins PAO-PA7, PB0O, PB2-PB?7,
PD2-PD7, PEO-PE1, PE3-PE7, PFO-PF7, and PGO-PG7.

Figure 5 shows the RCM3200 pinouts for headers J1 and J2.

J1 J2
GND |m o[ ] STATUS /RES[|®m o[ 1PBO
PA7] o o[1PA6 PB2 o o[ 1PB3
PASL|o o[ ]PA4 PB4 |oc o[ 1PB5
PA3|o o[ JPA2 PB6 o o[ PB7
PA1[] o o[1PAO PF4[ o o[ JPF5
PF3[|o o[ 1PF2 PF6 o o[ PF7
PF1 ] o o[1PFO PE7 |0 o[ PE6
PCO|o o[ 1PC1 PE5 |0 o[ PE4
PC2|o o[ JPC3 PE3 o o[ JPE1
PC4[ o o[ 1PC5 PEO o o[ PG7
PC6-TXA[| o ©[ ] PC7-RxA PG6 o o[PG5
PGO[ o o[ 1PG1 PG4 o o[ 1/IOWR
PG2[ o o[ 1PG3 /IORD | o ©o[] SMODO
PD4[|o o[ PD5 SMOD1 |5 o[ 1/RESET_IN
PD2[|o o[ 1PD3 VRAM [ o o[ VBAT_EXT
PD6 |0 o[ PD7 +33v] o o[ JGND
nec.l|o o[ Jne. nc. o o[ JGND
n.c. = not connected
Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 5. RCM3200 Pinouts

The pinouts for the RCM3000, RCM3100, and RCM3200 are compatible. Visit the Web site for
further information.

Headers J1 and J2 are standard 2 x 34 headers with a nominal 2 mm pitch. An RJ-45 Ether-
net jack is also included with the RCM3200 series.

The signals labeled PD2, PD3, PD6, and PD7 on header J1 (pins 29-32) and the pins that
are not connected (pins 33—-34 on header J1 and pin 33 on header J2) are reserved for
future use.
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Figure 6 shows the use of the Rabbit 3000 microprocessor ports in the RCM3200 modules.

PCO, PC2, PC4 4
PC1, PC3, PC5 NI

PG2, PG6 {um
PG3, PG7 I

PC6
PB1, PC7, /IRES

4 Ethernet signaIsH

nitst

PBO,
PAO-PA7 PB2-PB7 PD4-PD5
Port D
Port A Port B (+Ethernet Port)
Port C
(Serial Ports B,C & D) RABBIT Port E
3000
Port G
(Serial Ports E & F) Port F
Programming Real-Time Clock Port G
(SeriZIOI;-:J HA) Watchdog (+Serial Ports)
11 Timers
Ethernet Slave Port Misc. I/0
Port Clock Doubler
RAM Backup Battery Flash

Support

EO-PEA1,

P
PE3-PE7

PFO-PF7

PG0-PG1,

PG4-PG5

/RES_IN
/IORD

/RESET,
/IOWR,
STATUS
SMODEO
SMODE1

Figure 6. Use of Rabbit 3000 Ports

The ports on the Rabbit 3000 microprocessor used in the RCM3200 are configurable, and
so the factory defaults can be reconfigured. Table 1 lists the Rabbit 3000 factory defaults
and the alternate configurations.

User’'s Manual
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Table 1. RCM3200 Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
1 GND
2 STATUS Output (Status) Output
External data bus
IDO-1D7
3-10 PA[7:0] Parallel I/0 ( )
Slave port data bus
(SD0-SD7)
11 PF3 Input/Output QD2A
12 PF2 Input/Output QD2B
QD1A
13 PF1 Input/Output CLKC
QD1B
14 PFO Input/Output CLKD
15 PCO Output TXD
Serial Port D
16 PC1 Input RXD
17 PC2 Output TXC
Serial Port C
18 PC3 Input RXC
—
= |19 PC4 Output TXB
g Serial Port B
£ |20 PC5 Input RXB
21 PC6 OUtpUt TXA Serial Port A
22 PC7 Input RXA (programming port)
23 PGO Input/Output TCLKF Serial Clock F output
24 PG1 Input/Output RCLKF Serial Clock F input
25 PG2 Input/Output TXF
Serial Port F
26 PG3 Input/Output RXF
27 PD4 Input/Output ATXB
28 PD5 Input/Output ARXB
29 PD2 Input/Output TPOUT-*
Ethernet transmit port
30 PD3 Input/Output TPOUT+ *
31 PD6 Input/Output TPIN-*
Ethernet receive port
32 PD7 Input/Output TPIN+*
33 LNK_OUT | Output Max. current draw 1 mA
34 ACT OUT | Output (see Note 1)
* Pins 29-32 are reserved for future use.
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Table 1. RCM3200 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
1 /IRES Reset output Reset input Reset output from Reset
Generator
2 PBO Input/Output CLKB
1A0 External Address 0
3 PB2 Input/Output
purutpu /ISWR Slave port write
4 PB3 Input/Output 1ALl External Address 1
/SRD Slave port read
A2 External Address 2
5 PB4 Input/Output
npuviLtpu SA0 Slave port Address 0
IA3 External Address 3
6 PB5 Input/Output
npuvLtpu SAl Slave port Address 1
7 PB6 Input/Output I1A4 External Address 4
IA5 External Address 5
8 PBIY Input/Output ISLAVEATTN Slave Attention
AQD1B
9 PF4 Input/Output PWMO
S
= AQD1A
< |10 PF5 Input/Output
g purutpu PWM1
* AQD2B
11 PF6 Input/Output PWM2
12 PF7 Input/Output AQD2A
PWM3
13 PE7 Input/Output I7
RIS /SCS
14 PEG6 Input/Output 16
15
15 PE5 Input/Output
INT1B
16 PE4 Input/Output 14
RIS INTOB
17 PE3 Input/Output 13
11 I/0O Strobe 1
18 PE1 Input/Output
npuvLtpu INTLA Interrupt 1A
10 I/0 Strobe 0
19 PEO Input/Output
npuviLtpu INTOA Interrupt OA

User’'s Manual
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Table 1. RCM3200 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
20 PG7 Input/Output RXE
Serial Port E
21 PG6 Input/Output TXE
22 PG5 Input/Output RCLKE Serial Clock E input
23 PG4 Input/Output TCLKE Serial Clock E ouput
24 /IOWR Output External write strobe
25 /IORD Input External read strobe
(0,0)—start executing at address zero
(0,1)—cold boot from slave port
1,0)—cold boot from clocked Serial Port A
o | 26-27 SMODEQ, (L.0) ! Also connected to
o SMODE1 programming cable
% SMODEO =1, SMODE1 =1
£ Cold boot from asynchronous Serial Port A at
2400 bps (programming cable connected)
28 /RESET_IN | Input Input to Reset Generator
29 VRAM Output See Notes below table
Minimum battery
30 VBAT_EXT |3V battery Input voltage 2.85 V
31 +3.3V Input 3.15-3.45V DC
32 GND
33 n.c. Reserved for future use
34 GND
Notes

. When using pins 33-34 on header J1 to drive LEDs, you must use an external buffer to
drive these external LEDs. These pins are not connected on the RCM3220, which does
not have the LEDs installed.

. The VRAM voltage is temperature-dependent. If the VRAM voltage drops below about
1.2 V to 1.5V, the contents of the battery-backed SRAM may be lost. If VRAM drops

below 1.0 V, the 32 kHz oscillator could stop running. Pay careful attention to this volt-
age if you draw any current from this pin.

Locations R45, R46, R53, R57, and R74 allow the population of 0 Q resistors (jumpers)
that will be used to enable future options. These locations are currently unused.
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3.1.1 Memory I/O Interface

The Rabbit 3000 address lines (A0-A19) and all the data lines (D0-D7) are routed inter-
nally to the onboard flash memory and SRAM chips. 1/0 write (/IOWR) and 1/0 read
(/IORD) are available for interfacing to external devices.

Parallel Port A can also be used as an external 1/0O data bus to isolate external 1/0 from the
main data bus. Parallel Port B pins PB2—PB7 can also be used as an auxiliary address bus.

When using the auxiliary 1/0 bus, you must add the following line at the beginning of
your program.

#define PORTA AUX IO // required to enable auxiliary I/0 bus

The STATUS output has three different programmable functions:

3. It can be driven low on the first op code fetch cycle.

4. 1t can be driven low during an interrupt acknowledge cycle.
5. It can also serve as a general-purpose output.

3.1.2 Other Inputs and Outputs

Two status mode pins, SMODEO and SMODE1, are available as inputs. The logic state of
these two pins determines the startup procedure after a reset.

/RESET _IN is an external input used to reset the Rabbit 3000 microprocessor and the
RCM3200 memory. /RES is an output from the reset circuitry that can be used to reset
other peripheral devices.

3.1.3 5V Tolerant Inputs

The RCM3200 operates over a voltage from 3.15 V to 3.45 V, but most RCM3200 input
pins, except /RESET _IN, VRAM, VBAT_EXT, and the power-supply pins, are 5 V toler-
ant. When a 5 V signal is applied to 5 V tolerant pins, they present a high impedance even if
the Rabbit power is off. The 5 V tolerant feature allows 5 V devices that have a suitable
switching threshold to be connected directly to the RCM3200. This includes HCT family
parts operated at 5 V that have an input threshold between 0.8 and 2 V.

NOTE: CMOS devices operated at 5 V that have a threshold at 2.5 V are not suitable for
direct connection because the Rabbit 3000 outputs do not rise above VDD, and is often
specified as 3.3 V. Although a CMOS input with a 2.5 V threshold may switch at 3.3 V,
it will consume excessive current and switch slowly.

In order to translate between 5V and 3.3 V, HCT family parts powered from 5 V can be
used, and are often the best solution. There is also the “LVT” family of parts that operate
from 2.0 V to 3.3V, but that have 5 V tolerant inputs and are available from many suppli-
ers. True level-translating parts are available with separate 3.3 VV and 5 V supply pins, but
these parts are not usually needed, and have design traps involving power sequencing.
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3.2 Serial Communication

The RCM3200 board does not have an RS-232 or an RS-485 transceiver directly on the
board. However, an RS-232 or RS-485 interface may be incorporated on the board the
RCM3200 is mounted on. For example, the Prototyping Board has a standard RS-232
transceiver chip.

3.2.1 Serial Ports

There are six serial ports designated as Serial Ports A, B, C, D, E, and F. All six serial
ports can operate in an asynchronous mode up to the baud rate of the system clock divided
by 8. An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where
an additional bit is sent to mark the first byte of a message, is also supported. Serial Ports
A, B, C, and D can also be operated in the clocked serial mode. In this mode, a clock line
synchronously clocks the data in or out. Either of the two communicating devices can sup-
ply the clock. When the Rabbit 3000 provides the clock, the baud rate can be up to 80% of
the system clock frequency divided by 128, or 276,250 bps for a 44.2 MHz clock speed.

Serial Ports E and F can also be configured as SDLC/HDLC serial ports. The IrDA proto-
col is also supported in SDLC format by these two ports.

Serial Port A is available only on the programming port.
3.2.2 Ethernet Port

Figure 7 shows the pinout for the RJ-45 Ethernet port (J4). Note that some Ethernet con-
nectors are numbered in reverse to the order used here.

ETHERNET
' wms
1. E_Tx+
2. E_Tx-
3. E_Rx+
6. E_Rx—
RJ-45 Plug RJ-45 Jack

Figure 7. RJ-45 Ethernet Port Pinout
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Three LEDs are placed next to the RJ-45 Ethernet
jack, one to indicate an Ethernet link (LNK), one to
indicate Ethernet activity (ACT), and one to indicate
when the RCM3200 is connected to a functioning
100Base-T network (SPD).

The transformer/connector assembly ground is con- Board | | Chassis
nected to the RCM3200 printed circuit board digital Ground = - Ground
ground via a 0 Q resistor, R42, as shown in Figure 8.

RJ-45 Ethernet Plug

R42

S o Figure 8. Isolation Resistor R42
The RJ-45 connector is shielded to minimize EMI

effects to/from the Ethernet signals.
3.2.3 Programming Port

Serial Port A has special features that allow it to cold-boot the system after reset. Serial
Port A is also the port that is used for software development under Dynamic C.

The RCM3200 has a 10-pin program header labeled J3. The Rabbit 3000 startup-mode
pins (SMODEO, SMODEZ1) are presented to the programming port so that an externally
connected device can force the RCM3200 to start up in an external bootstrap mode. The
Rabbit 3000 Microprocessor User’s Manual provides more information related to the
bootstrap mode.

The programming port is used to start the RCM3200 in a mode where it will download a
program from the port and then execute the program. The programming port transmits
information to and from a PC while a program is being debugged in-circuit.

The RCM3200 can be reset from the programming port via the /RESET _IN line.

The Rabbit 3000 status pin is also presented to the programming port. The status pin is an
output that can be used to send a general digital signal.

The clock line for Serial Port A is presented to the programming port, which makes syn-
chronous serial communication possible.

Programming may also be initiated through the motherboard to which the RCM3200
series module is plugged in to since the Serial Port A (PC6 and PC7), SMODEO, SMODEL1,
and /RESET _IN are available on headers J1 and J2 (see Table 1).

3.2.3.1 Alternate Uses of the Programming Port

The programming port may also be used as an application port with the DIAG connector
on the programming cable.

All three clocked Serial Port A signals are available as
e asynchronous serial port
e an asynchronous serial port, with the clock line usable as a general CMOS input

¢ two general CMOS inputs and one general CMOS output.
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Two startup mode pins, SMODEO and SMODEL, are available as general CMOS inputs
after they are read during the initial boot-up. The logic state of these two pins is very
important in determining the startup procedure after a reset.

/RES_IN is an external input used to reset the Rabbit 3000 microprocessor.

The status pin may also be used as a general CMOS output.
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3.3 Programming Cable

The RCM3200 is automatically in program mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in run mode when no programming cable
is attached.

The DIAG connector of the programming cable may be used on header J3 of the RCM3200
with the board operating in the run mode. This allows the programming port to be used as
an application port.

+ cr - B
[e10)
Batt Seceleeetloteleleleielclolotoisielelelele
N 5,56000000000000000000000000

000000000000 O0OOOOOOOOOOOOO0O0OO000
2 0O000000000O0O0OOOOOOOOOOOOO0OOOO0O0

0000000000000

0000000000000

&

O0000000OOOOOOOOOOOOOOOOOOOOOO0O0
POOOOOO0000O00000OO0000OO0O0O0OOO0OOO000
POOOOOO0000O00O000O0000O0O0O0O0OOO00OO000
POOOOOO0000O00000OO0000OOO00OOO00OO000
POOOOO0OOO0000O0O00O00O0O0OOOOOOOOO0O000O0
olelelelolelelclolo]0)0)0l0l0l0]0l0l0l010]0l01010I0I0 0101010 0 010 06
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Programming Cable

To
=7 PC COM port

9000000000000000

Colored edge

RESET RCM3200 when changing mode:

Short out pins 28-32 on header J2, OR

Press RESET button (if using Prototyping Board), OR
Remove, then reapply power

after removing or attaching programming cable.

RESET

Figure 9. Switching Between Program Mode and Run Mode

3.3.1 Changing from Program Mode to Run Mode

1. Disconnect the programming cable from header J3 of the RCM3200.
2. Reset the RCM3200. You may do this as explained in Figure 9.

The RCM3200 is now ready to operate in the run mode.

3.3.2 Changing from Run Mode to Program Mode

1. Attach the programming cable to header J3 on the RCM3200.

2. Reset the RCM3200. You may do this as explained in Figure 9.

The RCM3200 is now ready to operate in the program mode.
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3.4 Other Hardware

3.4.1 Clock Doubler

The RCM3200 takes advantage of the Rabbit 3000 microprocessor’s internal clock dou-
bler. A built-in clock doubler allows half-frequency crystals to be used to reduce radiated
emissions. The 44.2 MHz frequency specified for the RCM3200 is generated using a
22.12 MHz resonator.

The clock doubler may be disabled if 44.2 MHz clock speeds are not required. Disabling

the Rabbit 3000 microprocessor’s internal clock doubler will reduce power consumption

and further reduce radiated emissions. The clock doubler is disabled with a simple change
to the BIOS as described below.

1. Open the BIOS source code file, RABBITBIOS.C in the BI0S directory.

2. Change the line

#define CLOCK DOUBLED 1 // set to 1 to double clock if
// Rabbit 2000: crystal <= 12.9024 MHz,
// Rabbit 3000: crystal <= 26.7264 MHz,
// or to 0 to always disable clock doubler

to read as follows.
#define CLOCK_DOUBLED 0

3. Save the change using File > Save.

3.4.2 Spectrum Spreader

The Rabbit 3000 features a spectrum spreader, which helps to mitigate EMI problems. By
default, the spectrum spreader is on automatically, but it may also be turned off or set to a
stronger setting. The means for doing so is through a simple change to the following BIOS
line in a way that is similar to the clock doubler described above.

#define ENABLE SPREADER 1 // Set to 0 to disable spectrum spreader,

// 1 to enable normal spreading, or
// 2 to enable strong spreading.

NOTE: The strong spectrum-spreading setting is not recommended since it may limit the
maximum clock speed or the maximum baud rate.
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3.5 Memory
3.5.1 SRAM

The RCM3200 has 512K of program execution SRAM installed at U8 and packaged in a
32-pin TSOP or sTSOP case. The data SRAM installed at U6 is 256K.

3.5.2 Flash EPROM

The RCM3200 is also designed to accept 256K to 512K of flash EPROM packaged in a
32-pin TSOP or sTSOP case. The flash EPROM installed at U7 is 512K

NOTE: Z-World recommends that any customer applications should not be constrained
by the sector size of the flash EPROM since it may be necessary to change the sector
size in the future.

Writing to arbitrary flash memory addresses at run time is also discouraged. Instead,
define a “user block” area to store persistent data. The functions writeUserBlock and
readUserBlock are provided for this.

A Flash Memory Bank Select jumper configuration option based on 0 € surface-mounted
resistors exists at header JP4 on the RCM3200 RabbitCore modules. This option, used in
conjunction with some configuration macros, allows Dynamic C to compile two different
co-resident programs for the upper and lower halves of the 512K flash in such a way that
both programs start at logical address 0000. This is useful for applications that require a
resident download manager and a separate downloaded program. See Technical Note
TN218, Implementing a Serial Download Manager for a 256K Flash, for details.

3.5.3 Dynamic C BIOS Source Files

The Dynamic C BIOS source files handle different standard RAM and flash EPROM sizes
automatically.
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4. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Z-World controllers and other controllers
based on the Rabbit microprocessor. Chapter 4 provides the
libraries and function calls related to the RCM3200.

4.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging in the real
environment. A complete reference guide to Dynamic C is contained in the Dynamic C
User’s Manual.

You have a choice of doing your software development in the flash memory or in the data
SRAM included on the RCM3200. The flash memory and SRAM options are selected
with the Options > Project Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited
to about 100,000 write cycles. The disadvantage is that the code and data might not both
fit in RAM.

NOTE: An application can be compiled directly to the battery-backed data SRAM, but
should be run from the program execution SRAM after the programming cable is dis-
connected. Your final code must always be stored in flash memory for reliable operation.
For RCM3200 modules running at 44.2 MHz, which have a fast program execution
SRAM that is not battery-backed, you should select Code and BIOS in Flash, Run in
RAM from the Dynamic C Options > Project Options > Compiler menu to store the
code in flash and copy it to the fast program execution SRAM at run-time to take
advantage of the faster clock speed. This option optimizes the performance of
RCM3200 modules running at 44.2 MHz.

NOTE: Do not depend on the flash memory sector size or type. Due to the volatility of
the flash memory market, the RCM3200 and Dynamic C were designed to accommo-
date flash devices with various sector sizes.

Developing software with Dynamic C is simple. Users can write, compile, and test C and
assembly code without leaving the Dynamic C development environment. Debugging
occurs while the application runs on the target. Alternatively, users can compile a program
to an image file for later loading. Dynamic C runs on PCs under Windows 95, 98, 2000,
NT, Me, and XP. Programs can be downloaded at baud rates of up to 460,800 bps after the
program compiles.
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Dynamic C has a number of standard features.

o Full-feature source and/or assembly-level debugger, no in-circuit emulator required.
¢ Royalty-free TCP/IP stack with source code and most common protocols.

e Hundreds of functions in source-code libraries and sample programs:

» Exceptionally fast support for floating-point arithmetic and transcendental functions.
» RS-232 and RS-485 serial communication.
» Analog and digital 1/O drivers.

» 12C, SPI, GPS, encryption, file system.
» LCD display and keypad drivers.
o Powerful language extensions for cooperative or preemptive multitasking

o Loader utility program to load binary images into Z-World targets in the absence of
Dynamic C.

e Provision for customers to create their own source code libraries and augment on-line
help by creating “function description” block comments using a special format for
library functions.

e Standard debugging features:

» Breakpoints—Set breakpoints that can disable interrupts.
» Single-stepping—Step into or over functions at a source or machine code level, pC/OS-I1 aware.

» Code disassembly—The disassembly window displays addresses, opcodes, mnemonics, and
machine cycle times. Switch between debugging at machine-code level and source-code level by
simply opening or closing the disassembly window.

P Watch expressions—Watch expressions are compiled when defined, so complex expressions
including function calls may be placed into watch expressions. Watch expressions can be updated
with or without stopping program execution.

» Register window—All processor registers and flags are displayed. The contents of general registers
may be modified in the window by the user.

» Stack window—shows the contents of the top of the stack.
» Hex memory dump—displays the contents of memory at any address.

» STDIO window—print£ outputs to this window and keyboard input on the host PC can be
detected for debugging purposes. print £ output may also be sent to a serial port or file.
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4.2 Dynamic C Function Calls
4.2.1 Digital I/O

The RCM3200 was designed to interface with other systems, and so there are no drivers
written specifically for the 1/0. The general Dynamic C read and write functions allow
you to customize the parallel 1/0 to meet your specific needs. For example, use

WrPortI (PEDDR, &PEDDRShadow, 0x00) ;
to set all the Port E bits as inputs, or use

WrPortI (PEDDR, &PEDDRShadow, OxFF);

to set all the Port E bits as outputs.
When using the auxiliary 1/0 bus on the Rabbit 3000 chip, add the line

#define PORTA AUX IO // required to enable auxiliary I/0 bus

to the beginning of any programs using the auxiliary 1/0 bus.

The sample programs in the Dynamic C SAMPLES/RCM3200 directory provide further
examples.

4.2.2 Serial Communication Drivers

Library files included with Dynamic C provide a full range of serial communications sup-
port. The Rs232.LIB library provides a set of circular-buffer-based serial functions. The
PACKET.LIB library provides packet-based serial functions where packets can be delim-
ited by the 9th bit, by transmission gaps, or with user-defined special characters. Both
libraries provide blocking functions, which do not return until they are finished transmit-
ting or receiving, and nonblocking functions, which must be called repeatedly until they
are finished. For more information, see the Dynamic C Function Reference Manual and
Technical Note 213, Rabbit 2000 Serial Port Software.

4.2.3 TCP/IP Drivers
The TCP/IP drivers are located in the TCPIP directory.

Complete information on these libraries and the TCP/IP functions is provided in the
Dynamic C TCP/IP User’s Manual.

4.2.4 Prototyping Board Function Calls

The functions described in this section are for use with the Prototyping Board features.
The source code is in the ReM32xx . LIB library in the Dynamic C SAMPLES\RCM3200
folder if you need to modify it for your own board design.

Other generic functions applicable to all devices based on Rabbit microprocessors are
described in the Dynamic C Function Reference Manual.
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4.2.4.1 Board Initialization

void brdInit (void);

Call this function at the beginning of your program. This function initializes Parallel Ports A through G
for use with the RCM3200 Prototyping Board.

Summary of Initialization
1. 1/0O port pins are configured for Prototyping Board operation.
2. Unused configurable 1/0O are set as high outputs.

3. Only one RabbitCore module is plugged in, and is in the MASTER position on the Prototyping
Board.

The LCD/keypad module is disabled.
RS-485 is not enabled.

RS-232 is not enabled.

The IrDA transceiver is disabled.
LEDs are off.

N o gk~ w

RETURN VALUE
None.
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4.3 Sample Programs
Sample programs are provided in the Dynamic C Samples folder.

The various folders contain specific sample programs that illustrate the use of the corre-
sponding Dynamic C libraries. For example, the sample program PONG . C demonstrates
the output to the Dynamic C STDIO window.

Two folders contain sample programs that illustrate features unique to the RCM3200.

e RCM3200—Demonstrates the basic operation and the Ethernet functionality of the
RCM3200.

e TCPIP—Demonstrates more advanced TCP/IP programming for Z-World’s Ethernet-
enabled Rabbit-based boards.

Follow the instructions included with the sample program to connect the RCM3200 and
the other hardware identified in the instructions.

If you are using an RCM3200 or RCM3220, you will need to allow the compiler to run the
application in the fast program execution SRAM by selecting Code and BIOS in Flash,
Run in RAM from the Compiler tab in the Dynamic C Options > Project Options menu.

To run a sample program, open it with the File menu (if it is not still open), then compile
and run it by selecting Run in the Run menu (or press F9). The RCM3200 must be in
Program Mode (see Figure 9) and must be connected to a PC using the programming
cable.

The sample programs for the RCM3200 are described in detail in the RCM3200 Getting
Started Manual.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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4.4 Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web
sites

e www.zworld.com/support/

or

e www.rabbitsemiconductor.com/support/

for the latest patches, workarounds, and bug fixes.

The default installation of a patch or bug fix is to install the file in a directory (folder) dif-
ferent from that of the original Dynamic C installation. Z-World recommends using a dif-
ferent directory so that you can verify the operation of the patch without overwriting the
existing Dynamic C installation. If you have made any changes to the BIOS or to libraries,
or if you have programs in the old directory (folder), make these same changes to the
BIOS or libraries in the new directory containing the patch. Do not simply copy over an
entire file since you may overwrite a bug fix; of course, you may copy over any programs
you have written.

4.4.1 Add-On Modules

Dynamic C installations are designed for use with the board they are included with, and
are included at no charge as part of our low-cost kits. Dynamic C is a complete software
development system, but does not include all the Dynamic C features. Z-World also offers
add-on Dynamic C modules containing the popular nC/OS-I1 real-time operating system,
as well as PPP, Advanced Encryption Standard (AES), and other select libraries. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support module is also available for purchase.
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5. USING THE TCP/IP FEATURES

5.1 TCP/IP Connections

Programming and development can be done with the RCM3200 RabbitCore modules
without connecting the Ethernet port to a network. However, if you will be running the
sample programs that use the Ethernet capability or will be doing Ethernet-enabled devel-
opment, you should connect the RCM3200 module’s Ethernet port at this time.

Before proceeding you will need to have the following items.

¢ If you don’t have Ethernet access, you will need at least a 10Base-T Ethernet card
(available from your favorite computer supplier) installed in a PC.

e Two RJ-45 straight through Ethernet cables and a hub, or an RJ-45 crossover Ethernet
cable.

The Ethernet cables and a 10Base-T Ethernet hub are available from Z-World in a TCP/IP
tool kit. More information is available at www.zworld.com.

NOTE: Although 10Base-T is the minimum required, 10/100Base-T or 100Base-T is
recommended to allow you to work with the full speed capabilities of the RCM3200.

1. Connect the AC adapter and the programming cable as shown in Section 2.2.2, “Con-
nect Programming Cable.”

2. Ethernet Connections

There are four options for connecting the RCM3200 module to a network for develop-
ment and runtime purposes. The first two options permit total freedom of action in
selecting network addresses and use of the “network,” as no action can interfere with
other users. We recommend one of these options for initial development.

e No LAN — The simplest alternative for desktop development. Connect the
RCM3200’s Ethernet port directly to the PC’s network interface card using an RJ-45
crossover cable. A crossover cable is a special cable that flips some connections
between the two connectors and permits direct connection of two client systems. A
standard RJ-45 network cable will not work for this purpose.

e Micro-LAN — Another simple alternative for desktop development. Use a small Eth-
ernet 10Base-T hub and connect both the PC’s network interface card and the
RCM3200’s Ethernet port to it, using standard network cables.
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The following options require more care in address selection and testing actions, as
conflicts with other users, servers and systems can occur:

LAN — Connect the RCM3200’s Ethernet port to an existing LAN, preferably one to
which the development PC is already connected. You will need to obtain IP addressing
information from your network administrator.

WAN — The RCM3200 is capable of direct connection to the Internet and other Wide
Area Networks, but exceptional care should be used with IP address settings and all
network-related programming and development. We recommend that development and
debugging be done on a local network before connecting a RabbitCore system to the
Internet.

TIP: Checking and debugging the initial setup on a micro-LAN is recommended before
connecting the system to a LAN or WAN.

The PC running Dynamic C through the serial port on the RCM3200 does not need to
be the PC with the Ethernet card.

3. Apply Power

Plug in the AC adapter. The RCM3200 module is now ready to be used.
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5.2 TCP/IP Primer on IP Addresses

Obtaining IP addresses to interact over an existing, operating, network can involve a num-
ber of complications, and must usually be done with cooperation from your ISP and/or
network systems administrator. For this reason, it is suggested that the user begin instead
by using a direct connection between a PC and the RCM3200 board using an Ethernet
crossover cable or a simple arrangement with a hub. (A crossover cable should not be con-
fused with regular straight through cables.)

In order to set up this direct connection, the user will have to use a PC without networking,
or disconnect a PC from the corporate network, or install a second Ethernet adapter and set
up a separate private network attached to the second Ethernet adapter. Disconnecting your
PC from the corporate network may be easy or nearly impossible, depending on how it is
set up. If your PC boots from the network or is dependent on the network for some or all
of its disks, then it probably should not be disconnected. If a second Ethernet adapter is
used, be aware that Windows TCP/IP will send messages to one adapter or the other,
depending on the IP address and the binding order in Microsoft products. Thus you should
have different ranges of IP addresses on your private network from those used on the cor-
porate network. If both networks service the same IP address, then Windows may send a
packet intended for your private network to the corporate network. A similar situation will
take place if you use a dial-up line to send a packet to the Internet. Windows may try to
send it via the local Ethernet network if it is also valid for that network.

The following IP addresses are set aside for local networks and are not allowed on the
Internet: 10.0.0.0 to 10.255.255.255, 172.16.0.0 to 172.31.255.255, and 192.168.0.0 to
192.168.255.255.

The RCM3200 board uses a 10/100Base-T type of Ethernet connection, which is the most
common scheme. The RJ-45 connectors are similar to U.S. style telephone connectors, are
except larger and have 8 contacts.

An alternative to the direct connection using a crossover cable is a direct connection using
a hub. The hub relays packets received on any port to all of the ports on the hub. Hubs are
low in cost and are readily available. The RCM3200 board uses 10 Mbps or 100 Mbps
Ethernet, so the hub or Ethernet adapter must be either a 10 Mbps unit or a 10/100 unit that
adapts to either 10 or 100 Mbps.

In a corporate setting where the Internet is brought in via a high-speed line, there are typi-
cally machines between the outside Internet and the internal network. These machines
include a combination of proxy servers and firewalls that filter and multiplex Internet traf-
fic. In the configuration below, the RCM3200 board could be given a fixed address so any
of the computers on the local network would be able to contact it. It may be possible to
configure the firewall or proxy server to allow hosts on the Internet to directly contact the
controller, but it would probably be easier to place the controller directly on the external
network outside of the firewall. This avoids some of the configuration complications by
sacrificing some security.
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If your system administrator can give you an Ethernet cable along with its IP address, the
netmask and the gateway address, then you may be able to run the sample programs with-
out having to setup a direct connection between your computer and the RCM3200 board.

You will also need the IP address of the nameserver, the name or IP address of your mail

server, and your domain name for some of the sample programs.

34 RabbitCore RCM3200



5.2.1 IP Addresses Explained

IP (Internet Protocol) addresses are expressed as 4 decimal numbers separated by periods,
for example:

216.103.126.155
10.1.1.6

Each decimal number must be between 0 and 255. The total IP address is a 32-bit number
consisting of the 4 bytes expressed as shown above. A local network uses a group of adja-

cent IP addresses. There are always 2N IP addresses in a local network. The netmask (also
called subnet mask) determines how many IP addresses belong to the local network. The
netmask is also a 32-bit address expressed in the same form as the IP address. An example
netmask is:

255.255.255.0

This netmask has 8 zero bits in the least significant portion, and this means that 28
addresses are a part of the local network. Applied to the IP address above
(216.103.126.155), this netmask would indicate that the following IP addresses belong to
the local network:

216.103.126.0

216.103.126.1

216.103.126.2

etc.

216.103.126.254

216.103.126.255

The lowest and highest address are reserved for special purposes. The lowest address
(216.102.126.0) is used to identify the local network. The highest address
(216.102.126.255) is used as a broadcast address. Usually one other address is used for the
address of the gateway out of the network. This leaves 256 - 3 = 253 available IP
addresses for the example given.
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5.2.2 How IP Addresses are Used

The actual hardware connection via an Ethernet uses Ethernet adapter addresses (also
called MAC addresses). These are 48-bit addresses and are unique for every Ethernet
adapter manufactured. In order to send a packet to another computer, given the IP address
of the other computer, it is first determined if the packet needs to be sent directly to the
other computer or to the gateway. In either case, there is an IP address on the local net-
work to which the packet must be sent. A table is maintained to allow the protocol driver
to determine the MAC address corresponding to a particular IP address. If the table is
empty, the MAC address is determined by sending an Ethernet broadcast packet to all
devices on the local network asking the device with the desired IP address to answer with
its MAC address. In this way, the table entry can be filled in. If no device answers, then
the device is nonexistent or inoperative, and the packet cannot be sent.

IP addresses are arbitrary and can be allocated as desired provided that they don’t conflict
with other IP addresses. However, if they are to be used with the Internet, then they must
be numbers that are assigned to your connection by proper authorities, generally by dele-
gation via your service provider.

Each RCM3200 RabbitCore module has its own unique MAC address, which consists of
the prefix 0090C2 followed by the code that appears on the label affixed to the RCM3200
module. For example, a MAC address might be 0090C2C002CO0.

TIP: You can always verify the MAC address on your board by running the sample pro-
gram DISPLAY MAC.C from the SAMPLES\TCPIP folder.
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5.2.3 Dynamically Assigned Internet Addresses

In many instances, there are no fixed IP addresses. This is the case when, for example, you
are assigned an IP address dynamically by your dial-up Internet service provider (ISP) or
when you have a device that provides your IP addresses using the Dynamic Host Configu-
ration Protocol (DHCP). The RCM3200 RabbitCore modules can use such IP addresses to
send and receive packets on the Internet, but you must take into account that this IP
address may only be valid for the duration of the call or for a period of time, and could be
a private IP address that is not directly accessible to others on the Internet. These private
address can be used to perform some Internet tasks such as sending e-mail or browsing the
Web, but usually cannot be used to participate in conversations that originate elsewhere on
the Internet. If you want to find out this dynamically assigned IP address, under Windows
XP you can run the ipcon£ ig program while you are connected and look at the interface
used to connect to the Internet.

Many networks use private IP addresses that are assigned using DHCP. When your com-
puter comes up, and periodically after that, it requests its networking information from a
DHCP server. The DHCP server may try to give you the same address each time, but a
fixed IP address is usually not guaranteed.

If you are not concerned about accessing the RCM3200 from the Internet, you can place
the RCM3200 on the internal network using a private address assigned either statically or
through DHCP.
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5.3 Placing Your Device on the Network

In many corporate settings, users are isolated from the Internet by a firewall and/or a
proxy server. These devices attempt to secure the company from unauthorized network
traffic, and usually work by disallowing traffic that did not originate from inside the net-
work. If you want users on the Internet to communicate with your RCM3200, you have
several options. You can either place the RCM3200 directly on the Internet with a real
Internet address or place it behind the firewall. If you place the RCM3200 behind the fire-
wall, you need to configure the firewall to translate and forward packets from the Internet
to the RCM3200.
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5.4 Running TCP/IP Sample Programs

We have provided a number of sample programs demonstrating various uses of TCP/IP for
networking embedded systems. These programs require you to connect your PC and the
RCM3200 board together on the same network. This network can be a local private net-
work (preferred for initial experimentation and debugging), or a connection via the Internet.

RCM3200
Board RCM3200
Board
User’s PC - [
ser’s
/( Ethernet /'/l
Ethernet cables N
crossover m |Z|/|;| El\> To additional
cable network
; . Hub \_/f elements
Direct Connection . : .
(network of 2 computers) Direct Connection Using a Hub
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5.4.1 How to Set IP Addresses in the Sample Programs

With the introduction of Dynamic C 7.30 we have taken steps to make it easier to run
many of our sample programs. Instead of theMmy 1P ADDRESS and other macros, you will
see a TCPCONFIG macro. This macro tells Dynamic C to select your configuration from a
list of default configurations. You will have three choices when you encounter a sample
program with the TCPCONFIG macro.

1. You can replace the TcpcoNFIG macro with individual MY IP ADDRESS,
MY NETMASK, MY GATEWAY, and MY NAMESERVER Macros in each program.

2. You can leave TcpCONFIG at the usual default of 1, which will set the IP configurations
t010.10.6.100, the netmask to 255.255.255. 0, and the nameserver and gateway
to10.10.6.1. If youwould like to change the default values, for example, to use an IP
addressof 10.1.1.2 for the RCM3200 board, and 10.1. 1.1 for your PC, you can edit
the values in the section that directly follows the “General Configuration” comment in
the Tcp_coNrF1e.LIB library. You will find this library in the LIB/TCPIP directory.

3. You can create a CUSTOM CONFIG.LIB library and use a TCPCONFIG value greater
than 100. Instructions for doing this are at the beginning of the TcP_CONFIG.LIB file.

There are some other “standard” configurations for TcPcoNFIG that let you select differ-
ent features such as DHCP. Their values are documented at the top of the
TCP_CONFIG.LIB library. More information is available in the Dynamic C TCP/IP
User’s Manual.

IP Addresses Before Dynamic C 7.30

Most of the sample programs such as shown in the example below use macros to define the
IP address assigned to the board and the IP address of the gateway, if there is a gateway.

#define MY IP ADDRESS "10.10.6.170"
#define MY NETMASK "255.255.255.0"
#define MY GATEWAY "10.10.6.1"
#define MY NAMESERVER "10.10.6.1"

In order to do a direct connection, the following IP addresses can be used for the RCM3200:

#define MY IP ADDRESS "10.1.1.2"

#define MY NETMASK "255.255.255.0"

// #define MY GATEWAY "10.10.6.1"

// #define MY NAMESERVER "10.10.6.1"
In this case, the gateway and nameserver are not used, and are commented out. The IP
address of the board is defined to be 10.1.1.2. The IP address of your PC can be defined
as10.1.1.1.
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5.4.2 How to Set Up your Computer’s IP Address for Direct Connect

When your computer is connected directly to the RCM3200 board via an Ethernet connec-
tion, you need to assign an IP address to your computer. To assign the PC the address
10.10.6.101 with the netmask 255.255.255. 0, do the following.

Click on Start > Settings > Control Panel to bring up the Control Panel, and then dou-
ble-click the Network icon. Depending on which version of Windows you are using, look
for the TCP/IP Protocol/Network > Dial-Up Connections/Network line or tab. Double-
click on this line or select Properties or Local Area Connection > Properties to bring
up the TCP/IP properties dialog box. You can edit the IP address and the subnet mask
directly. (Disable “obtain an IP address automatically.”) You may want to write down the
existing values in case you have to restore them later. It is not necessary to edit the gate-
way address since the gateway is not used with direct connect.

RCM3200
IP 10.10.6.101 Board
Netmask
255.255.255.0 K/
User’s PC/ -

Ethernet

crossover

cable

Direct Connection PC to RCM3200 Board

5.4.3 Dynamic C Compiler Settings

If you are using an RCM3200 or RCM3220, remember to allow the compiler to run the
application in the program execution SRAM by selecting Code and BIOS in Flash, Run
in RAM from the Dynamic C Options > Project Options > Compiler menu.
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5.5 Run the PINGME.C Sample Program

Connect the crossover cable from your computer’s Ethernet port to the RCM3200 board’s
RJ-45 Ethernet connector. Open this sample program from the SAMPLES\TCPIP\ICMP
folder, compile the program, and start it running under Dynamic C. When the program
starts running, the green LNK light on the RCM3200 board should be on to indicate an
Ethernet connection is made. (Note: If the LNK light does not light, you may not have a
crossover cable, or if you are using a hub perhaps the power is off on the hub.)

The next step is to ping the board from your PC. This can be done by bringing up the MS-
DOS window and running the pingme program:

ping 10.10.6.100
or by Start > Run

and typing the entry

ping 10.10.6.100
Notice that the red ACT light flashes on the RCM3200 board while the ping is taking

place, and indicates the transfer of data. The ping routine will ping the board four times
and write a summary message on the screen describing the operation.

5.6 Running More Sample Programs With Direct Connect

The sample programs discussed here are in the Dynamic C SAMPLES\RCM3200\TCPIP\
folder.

e BROWSELED.C—This program demonstrates a basic controller running a Web page.
Two “LEDs” are created on the Web page, and two buttons on the Prototyping Board
then toggle them. Users can change the status of the lights from the Web browser. The
LEDs on the Prototyping Board match the ones on the Web page. As long as you have
not modified the TcPCONFIG 1 macro in the sample program, enter the following server
address in your Web browser to bring up the Web page served by the sample program.

http://10.10.6.100.
Otherwise use the TCP/IP settings you entered in the TCP_CONFIG.LIB library.

e ECHOCLIENT.C—This program demonstrates a basic client that will send a packet and
wait for the connected server to echo it back. After every number of sends and receives,
transfer times are shown in the STDIO window.

Use ECHO SERVER.C to program a server controller.

e ECHOSERVER.C—This program demonstrates a basic server that will echo back any
data sent from a connected client.

Use ECHO CLIENT.C to program a client controller.

e ENET AD.C—This program demonstrates Ethernet communication between two
single-board computers. The program sends an A/D voltage value to the second single-
board computer via Ethernet for display.

Use ENET MENU. C to program the other single-board computer.
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e ENET MENU.C—This program demonstrates how to implement a menu system using a
highlight bar on a graphic LCD display and to communicate it to another single-board
computer via Ethernet.

Use ENET AD.C to program the other single-board computer with analog inputs and
outputs.

e MBOXDEMO.C—Implements a Web server that allows e-mail messages to be entered
and then shown on the LCD/keypad module.

e sMTP.C—This program allows you to send an E-mail when a switch on the Prototyp-
ing Board is pressed. Follow the instructions included with the sample program.

e PINGLED.C—This program demonstrates ICMP by pinging a remote host. It will flash
LEDs DS1 and DS2 on the Prototyping Board when a ping is sent and received.

5.7 Where Do | Go From Here?

NOTE: If you purchased your RCM3200 through a distributor or through a Z-World or
Rabbit Semiconductor partner, contact the distributor or Z-World partner first for tech-
nical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at
www.zworld.com/support/bb/.

e Use the Technical Support e-mail form at www.zworld.com/support/questionSubmit.shtml.
If the sample programs ran fine, you are now ready to go on.
Additional sample programs are described in the Dynamic C TCP/IP User’s Manual.

Please refer to the Dynamic C TCP/IP User’s Manual to develop your own applications.
An Introduction to TCP/IP provides background information on TCP/IP, and is available
on the CD and on Z-World’s Web site.
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APPENDIX A. RCM3200 SPECIFICATIONS

Appendix A provides the specifications for the RCM3200, and
describes the conformal coating.
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A.l1 Electrical and Mechanical Characteristics
Figure A-1 shows the mechanical dimensions for the RCM3200.

Please refer to the RCM3200
footprint diagram later in this
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Figure A-1. RCM3200 Dimensions

NOTE: All measurements are in inches followed by millimeters enclosed in parentheses.
All dimensions have a manufacturing tolerance of £0.01" (0.25 mm).
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the
RCM3200 in all directions (except above the RJ-45 plug) when the RCM3200 is incorpo-
rated into an assembly that includes other printed circuit boards. This “exclusion zone”
that you keep free of other components and boards will allow for sufficient air flow, and
will help to minimize any electrical or electromagnetic interference between adjacent
boards. An “exclusion zone” of 0.08" (2 mm) is recommended below the RCM3200
when the RCM3200 is plugged into another assembly using the shortest connectors for
headers J1 and J2. Figure A-2 shows this “exclusion zone.”
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Figure A-2. RCM3200 “Exclusion Zone”

User’s Manual

a7



Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM3200.

Table A-1. RabbitCore RCM3200 Specifications

Feature RCM3200 RCM3210 RCM3220
: ® : ® : ®

Microprocessor Rabbit 3000 at Rabbit 3000 at Rabbit 3000 at
44,2 MHz 29.5 MHz 44,2 MHz

EMI Reduction

Spectrum spreader for reduced EMI (radiated emissions)

Ethernet Port 10/100Base-T, RJ-45, 3 LEDs —

Flash Memory 512K 256K 512K
Data SRAM 256K 128K 256K
Program Execution SRAM 512K — 512K

Backup Battery

Connection for user-supplied backup battery
(to support RTC and data SRAM)

General-Purpose 1/0

52 parallel digital 1/0 lines:
* 44 configurable 1/0
* 4 fixed inputs
* 4 fixed outputs

Additional Inputs

Startup mode (2), reset in

Additional Outputs

Status, reset out

Auxiliary 1/0 Bus

Can be configured for 8 data lines and
6 address lines (shared with parallel 1/O lines), plus 1/0 read/write

6 shared high-speed, CMOS-compatible ports:

e all 6 configurable as asynchronous (with IrDA), 4 as clocked serial (SPI),
and 2 as SDLC/HDLC (with IrDA)

Serial Ports
e 1 asynchronous serial port dedicated for programming
e support for MIR/SIR IrDA transceiver
Serial Rate Maximum asynchronous baud rate = CLK/8

Slave Interface

A slave port allows the RCM3200 to be used as an intelligent peripheral
device slaved to a master processor, which may either be another Rabbit
3000 or any other type of processor

Real-Time Clock

Yes

Timers

Ten 8-bit timers (6 cascadable), one 10-bit timer with 2 match registers

Watchdog/Supervisor

Yes

Pulse-Width Modulators

10-bit free-running counter and four pulse-width registers

Input Capture

2- channel input capture can be used to time input signals from various port
pins

Quadrature Decoder

2-channel quadrature decoder accepts inputs from external incremental
encoder modules

Power

3.15Vt03.45VDC
255mA @ 3.3V
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Table A-1. RabbitCore RCM3200 Specifications (continued)

Feature RCM3200 RCM3210 RCM3220
Operating Temperature -40°C to +70°C
Humidity 5% to 95%, noncondensing
Connectors Two 2 x 17, 2 mm pitch
Board Size 1.850" x 2.725" x 0.86"
(47 mm x 69 mm x 22 mm)

A.1.1 Headers

The RCM3200 uses headers at J1 and J2 for physical connection to other boards. J1 and J2
are 2 x 17 SMT headers with a 2 mm pin spacing. J3, the programming port, isa 2 x 5
header with a 1.27 mm pin spacing.

Figure A-3 shows the layout of another board for the RCM3200 to be plugged into. These
values are relative to the mounting hole.

A.1.2 Physical Mounting

A 9/32” (7 mm) standoff with a 2-56 screw is recommended to attach the RCM3200 to a
user board at the hole position shown in Figure A-3. Either use plastic hardware, or use
insulating washers to keep any metal hardware from shorting out signals on the RCM3200.
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Figure A-3. User Board Footprint for RCM3200
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A.2 Bus Loading

You must pay careful attention to bus loading when designing an interface to the
RCM3200. This section provides bus loading information for external devices.

Table A-2 lists the capacitance for the various RCM3200 1/O ports.

Table A-2. Capacitance of Rabbit 3000 I/O Ports

Input Output
I/O Ports Capacitance Capacitance
(pF) (pF)
Parallel Ports Ato G 12 14

Table A-3 lists the external capacitive bus loading for the various RCM3200 output ports.
Be sure to add the loads for the devices you are using in your custom system and verify
that they do not exceed the values in Table A-3.

Table A-3. External Capacitive Bus Loading -40°C to +70°C

St Ba Clock Speed Maximum External
P (MHz) | Capacitive Loading (pF)

All 1/0 lines with clock
doubler enabled 29.4 30-70

All 1/0 lines with clock
doubler disabled 14.7456 100
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Figure A-4 shows a typical timing diagram for the Rabbit 3000 microprocessor external
1/0 read and write cycles.

NOTE: /IOCSx can be programmed to be active low (default) or active high.

External I/O Read (no extra wait states)
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7 Tadr
/CSx | | \__
1 Tcsx Tesx <7
/I0CSx K -
1 Tiocsx Tiocsx|<]
/IORD -
TiorD TiorRD[<]
/BUFEN -
“1TBUFEN TBUFﬁN‘_’
setup, |
D[7:0] < X _valid -
| Thold <"
External I/O Write (no extra wait states)
k—T1 | Tw—] T2 ——)
o | | |
A[15:01 — X valid : C
7 Tadr ‘
\
ICSx | 1 \ N
I Tcsx } Tesx[7
/I0CSx ! ) &
1 Tiocsx { Tiocsx[<
/IOWR ‘ R
Tiowr TiowR[<™]
/BUFEN 8
~1TBUFEN TBUFEN]
D[7:0] valid —
TbHzv ‘ TovHz <

Figure A-4. 1/0 Read and Write Cycles—No Extra Wait States
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Table A-4 lists the delays in gross memory access time for Vpp = 3.3 V.

Table A-4. Data and Clock Delays Vpp £#10%, Temp, -40°C—+85°C (maximum)

Clock to Address Output Delay Spectrum Spreader Delay
(ns) Data Setup (ns)
VDD Time Delay
30 pE 60 DE 90 bF (ns) Normal Strong
P P P dbl/no dbl | dbl/no dbl
3.3 6 8 11 1 3/4.5 4.5/9

The measurements are taken at the 50% points under the following conditions.
o T=-40°C t0 85°C, V = Vpp +10%

¢ Internal clock to nonloaded CLK pin delay <1 ns @ 85°C/3.0 V

The clock to address output delays are similar, and apply to the following delays.
e T.q4pr the clock to address delay

o Ty the clock to memory chip select delay

* Tiocsx the clock to 1/0 chip select delay

* T,0rD, the clock to I/O read strobe delay

e T,owr the clock to I/0 write strobe delay

e Tguren, the clock to I/0 buffer enable delay

The data setup time delays are similar for both Tget,, and Tpoyg.

When the spectrum spreader is enabled with the clock doubler, every other clock cycle is
shortened (sometimes lengthened) by a maximum amount given in the table above. The
shortening takes place by shortening the high part of the clock. If the doubler is not
enabled, then every clock is shortened during the low part of the clock period. The maxi-
mum shortening for a pair of clocks combined is shown in the table.

Technical Note TN227, Interfacing External 1/0 with Rabbit 2000/3000 Designs, con-
tains suggestions for interfacing 1/0 devices to the Rabbit 3000 microprocessors.
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A.3 Rabbit 3000 DC Characteristics

Table A-5 outlines the DC characteristics for the Rabbit at 3.3 V over the recommended
operating temperature range from T, = -55°C to +125°C, Vpp =3.0 V10 3.6 V.

Table A-5. 3.3 Volt DC Characteristics

Symbol Parameter Test Conditions Min Typ Max | Units
T Input Leakage High ViN=Vpp: Vpp =33V 1 HA
Input Leakage Low _ _
| VN =Vss, Vpp=33V |-
IL (no pull-up) IN = Vss: VDD 1 HA
Vin = Vpp 0Or Vs,
| - -
oz Output Leakage (no pull-up) Vpp =33V 1 1 HA
ViU CMOS Input Low Voltage 0.3xVpp |V
\m CMOS Input High Voltage 0.7 X Vpp
V1 CMOS Switching Threshold | Vpp =3.3V, 25°C 1.65 Vi
loL = See (sinking)
VoL Low-Level Output Voltage 0.4 \%
VDD =30V
v High-Level O Vol lon = See (sourcing) 0.7 XV v
- tput t g X
OH igh-Level Output Voltage Vop =30V DD
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A.4 1/0O Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit 1/0 buffers are capable of sourcing and sinking
6.8 mA of current per pin at full AC switching speed. Full AC switching assumes a
29.4 MHz CPU clock and capacitive loading on address and data lines of less than 70 pF
per pin. The absolute maximum operating voltage on all I/O is 5.5 V.

Table A-6 shows the AC and DC output drive limits of the parallel 1/0 buffers when the
Rabbit 3000 is used in the RCM3200.

Table A-6. I/O Buffer Sourcing and Sinking Capability

Output Drive (Full AC Switching)

Sourcing/Sinking Limits

Pin Name (MA)
Sourcing Sinking
All data, address, and 1/0
lines with clock doubler 6.8 6.8
enabled

Under certain conditions, the maximum instantaneous AC/DC sourcing or sinking current
may be greater than the limits outlined in Table A-6. The maximum AC/DC sourcing cur-
rent can be as high as 12.5 mA per buffer as long as the number of sourcing buffers does
not exceed three per Vpp or Vgg pad, or up to six outputs between pads. Similarly, the
maximum AC/DC sinking current can be as high as 8.5 mA per buffer as long as the num-
ber of sinking buffers does not exceed three per Vpp or Vgg pad, or up to six outputs
between pads. The Vpp bus can handle up to 35 mA, and the Vgg bus can handle up to
28 mA. All these analyses were measured at 100°C.
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A.5 Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator has had the Dow Corning
silicone-based 1-2620 conformal coating applied. The conformally coated area is shown
in Figure A-5. The conformal coating protects these high-impedance circuits from the

effects of moisture and contaminants over time.

Conformally coated
area

-
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=
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i

Figure A-5. RCM3200 Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering
procedures for surface-mounted components. A new conformal coating should then be
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note 303, Con-
formal Coatings.
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A.6 Jumper Configurations

Figure A-6 shows the header locations used to configure the various RCM3200 options
via jumpers.

Table A-7 lists the configuration options.
Table A-7. RCM3200 Jumper Configurations

Top Side

Bottom Side

'I:IJP1

]

Figure A-6. Location of RCM3200 Configurable Positions

Header Description Pins Connected eteiels
Default
1-2 | Buffer disabled
JP1 | Auxiliary I/O data bus
2-3 | Buffer enabled X
1-2 | 128K/256K
JP2 | Program Execution SRAM Size
2-3 |512K X
1-2 | 128K/256K
JP3 | Flash Memory Size
2-3 |512K X
1-2 | Normal Mode X
JP4 | Flash Memory Bank Select
2-3 | Bank Mode
1-2 | 256K X
JP5 Data SRAM Size
2-3 |512K

NOTE: The jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX B. PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board, and explains the use of the Prototyping Board to
demonstrate the RCM3200 and to build prototypes of your own
circuits.
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B.1 Introduction

The Prototyping Board included in the Development Kit makes it easy to connect an
RCM3200 module to a power supply and a PC workstation for development. It also pro-
vides some basic 1/0 peripherals (switches and LEDSs), as well as a prototyping area for
more advanced hardware development.

For the most basic level of evaluation and development, the Prototyping Board can be
used without modification.

As you progress to more sophisticated experimentation and hardware development, modi-
fications and additions can be made to the board without modifying or damaging the
RCM3200 module itself.

The Prototyping Board is shown below in Figure B-1, with its main features identified.

Voltage

Slave Module RCM3000/RCM3100/ Current- Regulators Power
Extension Headers RCM3200 Slave Module Measurement
Connectors Header \ Power

IrDA
Transceiver

0000000000000 0OOOOOOO0OO0O
[EOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOO

4/000000000000000000000000000000000 Through-Hole
000000000000000O0O000000000O000000! Prototyping Area
0000000000000000000000000000000000
0000000000000000OO00000000O000000000!
00000000000O00000OO000000O00000O00000!

RCM3000/RCM3100/
RCM3200 Master
Module Connectors

SMT Prototypmg
Area

o SEE e Eﬂ

:[3 o8 g LLL = | 0000000000000 00O0O00O0O0O00O0O0O0O0O0O0O00O0O0! ~
Dé% B 00000000 \+5 V, 3.3V, and
L3 F PQW@K. GND Buses
S :
SMT Prototyplng
Area g
FCe gg MHEE i
= % e\ 0
> ‘ ] ] Q Q O ....... O
Reset \ User LCD/Ke pad
Master Module RS 232 LEDs Mod 3|/
Extension Headers Switch Signal User odule
Connections
Header Switches

Figure B-1. Prototyping Board
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B.1.1 Prototyping Board Features

Power Connection—A power-supply jack and a 3-pin header are provided for con-
nection to the power supply. Note that the 3-pin header is symmetrical, with both outer
pins connected to ground and the center pin connected to the raw V+ input. The cable
of the AC adapter provided with the North American version of the Development Kit
ends in a plug that connects to the power-supply jack. The header plug leading to bare
leads provided for overseas customers can be connected to the 3-pin header in either
orientation.

Users providing their own power supply should ensure that it delivers 8-24 V DC at
8 W. The voltage regulators will get warm while in use.

Regulated Power Supply—The raw DC voltage provided at the POWER IN jack is
routed to a 5 V switching voltage regulator, then to a separate 3.3 V linear regulator.
The regulators provide stable power to the RCM3200 module and the Prototyping
Board.

Power LED—The power LED lights whenever power is connected to the Prototyping
Board.

Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM3200’s /RESET_IN pin. Pressing the switch forces a hardware reset of the system.

I/O Switches and LEDs—Two momentary-contact, normally open switches are con-
nected to the PGO and PG1 pins of the master RCM3200 module and may be read as
inputs by sample applications.

Two LEDs are connected to the PG6 and PG7 pins of the master module, and may be
driven as output indicators by sample applications.

Prototyping Area—A generous prototyping area has been provided for the installation
of through-hole components. +3.3 V, +5 V, and Ground buses run around the edge of
this area. Several areas for surface-mount devices are also available. (Note that there
are SMT device pads on both top and bottom of the Prototyping Board.) Each SMT pad
is connected to a hole designed to accept a 30 AWG solid wire.

Master Module Connectors—A set of connectors is pre-wired to permit installation
of the first RCM3000, RCM3100, or RCM3200 module that serves as the primary or
“master module.”

Slave Module Connectors—A second set of connectors is pre-wired to permit instal-
lation of a second, slave RCM3200, RCM3100, or RCM3000 module. This capability
is reserved for future use, although the schematics in this manual contain all of the
details an experienced developer will need to implement a master-slave system.

Module Extension Headers—The complete pin sets of both the MASTER and
SLAVE RabbitCore modules are duplicated at these two sets of headers. Developers
can solder wires directly into the appropriate holes, or, for more flexible development,
26-pin header strips can be soldered into place. See Figure B-4 for the header pinouts.
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RS-232—Two 3-wire or one 5-wire RS-232 serial port are available on the Prototyping
Board. Refer to the Prototyping Board schematic (090-0137) for additional details.

A 10-pin 0.1-inch spacing header strip is installed at J5 to permit connection of a ribbon
cable leading to a standard DE-9 serial connector.

Current Measurement Option—Jumpers across pins 1-2 and 5-6 on header JP1 can
be removed and replaced with an ammeter across the pins to measure the current drawn
from the +5 V or the +3.3 V supplies, respectively.

Motor Encoder—A motor/encoder header is provided at header J6 for future use.

LCD/Keypad Module—Z-World’s LCD/keypad module may be plugged in directly to
headers J7, J8, and J10.
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B.2 Mechanical Dimensions and Layout

Figure B-2 shows the mechanical dimensions and layout for the Prototyping Board.
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Figure B-2. RCM30/31/32XX Prototyping Board Dimensions
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Table B-1 lists the electrical, mechanical, and environmental specifications for the Proto-
typing Board.

Table B-1. Prototyping Board Specifications

Parameter Specification
Board Size 5.25" x 6.75" x 1.00" (133 mm x 171 mm x 25 mm)
Operating Temperature —20°C to +60°C
Humidity 5% to 95%, noncondensing
Input Voltage 8Vto24VDC
Maximum Current Draw 800 mA max. for +3.3 V supply,

(including user-added circuits) | 1 A total +3.3 V and +5 V combined

2.0" x 3.5" (50 mm x 90 mm) throughhole, 0.1" spacing,

Prototyping Area additional space for SMT components

Standoffs/Spacers 5, accept 4-40 x 3/8 screws

B.3 Power Supply

The RCM3200 requires a regulated 3.3 V £ 0.15 V DC power source to operate. Depend-
ing on the amount of current required by the application, different regulators can be used
to supply this voltage.

The Prototyping Board has an onboard +5 V switching power regulator from which a
+3.3 V linear regulator draws its supply. Thus both +5 V and +3.3 V are available on the
Prototyping Board.

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2
as shown in Figure B-3.

LINEAR POWER
ot SWITCHING POWER REGULATOR 5V REGULATOR 33y
[1d 1 LM1117
L2 o [+raw b2 _ DCIN s Ut |
5~ Pt us
g B DL4003 1017 l ,
147 uF [ 330 4H 1340 HF T Im 17
= LM2575 Li =
= Ly D1 = =
E 15 i1N5819

Figure B-3. Prototyping Board Power Supply
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B.4 Using the Prototyping Board

The Prototyping Board is actually both a demonstration board and a prototyping board. As
a demonstration board, it can be used to demonstrate the functionality of the RCM3200
right out of the box without any modifications to either board. There are no jumpers or dip
switches to configure or misconfigure on the Prototyping Board so that the initial setup is
very straightforward.

The Prototyping Board comes with the basic components necessary to demonstrate the
operation of the RCM3200. Two LEDs (DS1 and DS2) are connected to PG6 and PG?7,
and two switches (S2 and S3) are connected to PG1 and PGO to demonstrate the interface
to the Rabbit 3000 microprocessor. Reset switch S1 is the hardware reset for the
RCM3200.

The Prototyping Board provides the user with RCM3200 connection points brought out con-
veniently to labeled points at headers J2 and J4 on the Prototyping Board. Small to medium
circuits can be prototyped using point-to-point wiring with 20 to 30 AWG wire between the
prototyping area and the holes at locations J2 and J4. The holes are spaced at 0.1" (2.5 mm),
and 40-pin headers or sockets may be installed at J2 and J4. The pinouts for locations J2 and
J4, which correspond to headers J1 and J2, are shown in Figure B-4.

J2 J4
GND |0 o|n.c. PD1|o ©o|PDO
GND |0 o] +3.3V PD7|c ©o|PD6
VBAT EXT |o o | VRAM PD3|c ©o|PD2
/RESET_IN [ o ©o| SMODE1 PD5|c o |PD4
SMODEO | o o | /IORD PG3 |0 o|PG2
IOWR | & o | PG4 PG1|o o|PGO
PG5 |0 o|PG6 PC7 |2 =|PC6
PG7 |0 o|PEO PC5|2 o |PC4
PE1|o ol PE3 PC3|o o|PC2
PE4 |0 ©o| PE5 PC1|o ©|PCO
PE6 |2 o| PE7 PFO |2 o |PF1
PF7 |c ©o| PF6 PF2|= ©o|PF3
PF5|c o| PF4 PAO |2 ©|PA1
PB7 |0 ©| PB6 PA2 |© ©|PA3
PB5 |0 0| PB4 PA4 |© o |PA5
PB3 |0 ©o|PB2 PA6 | = ©|PA7
PBO | M| /RES STATUS |© B | GND
n.c. = not connected

Figure B-4. Prototyping Board Pinout
(Top View)

The small holes are also provided for surface-mounted components that may be installed
around the prototyping area.

There is a 2.0" x 3.5" through-hole prototyping space available on the Prototyping Board.
+3.3V, +5V, and GND traces run along the edge of the Prototyping Board for easy access.
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B.4.1 Adding Other Components

There are pads that can be used for surface-mount prototyping involving SOIC devices.
There is provision for seven 16-pin devices (six on one side, one on the other side). There
are 10 sets of pads that can be used for 3- to 6-pin SOT23 packages. There are also pads
that can be used for SMT resistors and capacitors in an 0805 SMT package. Each compo-
nent has every one of its pin pads connected to a hole in which a 30 AWG wire can be sol-
dered (standard wire wrap wire can be soldered in for point-to-point wiring on the
Prototyping Board). Because the traces are very thin, carefully determine which set of
holes is connected to which surface-mount pad.

B.4.2 Measuring Current Draw

The Prototyping Board has a current-measurement feature available on header JP1. Nor-
mally, a jumper connects pins 1-2 and pins 5-6 on header JP1, which provide jumper con-
nections for the +5 V and the +3.3 V regulated voltages respectively. You may remove a
jumper and place an ammeter across the pins instead, as shown in the example in

Figure B-5, to measure the current being drawn.

NG
O

IN3H4NO

+
w
w
<
NOILdO
ININFHNSYIN
bdr

Figure B-5. Prototyping Board Current-Measurement Option
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B.4.3 Other Prototyping Board Modules and Options

With the RCM3200 plugged into the MASTER slots, it has full access to the RS-232 trans-
ceiver, and can act as the “master” relative to another RabbitCore RCM3000, RCM3100,
or RCM3200 plugged into the SLAVE slots, which acts as the “slave.”

An optional LCD/keypad module is available that can be mounted on the Prototyping
Board. Refer to Appendix C, “LCD/Keypad Module,” for complete information.

The RCM3200 has a 2-channel quadrature decoder and a 10-bit free-running PWM
counter with four pulse-width registers. These features allow the RCM3200 to be used in a
motor control application, although Z-World does not offer the drivers or a compatible
stepper motor control board at this time.

The Prototyping Board has a header at J6 to which a customer-developed motor encoder
may be connected. Figure B-6 shows the motor encoder pinout at header J6.

J6
PFO (m o| PF1
PF2 |0 o|PF3
PF4 |o o|PF5
PF6 |0 o |PF7
+5V |2 2| GND

Figure B-6. Prototyping Board Motor Encoder
Connector Pinout

Refer to Appendix E, “Motor Control Option,” for complete information on using the
Rabbit 3000’s Parallel Port F in conjunction with this application.
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B.5 Use of Rabbit 3000 Parallel Ports

Table B-2 lists the Rabbit 3000 parallel ports and their use for the RCM30/31/32XX
Prototyping Board.

Table B-2. RCM30/31/32XX Prototyping Board
Use of Rabbit 3000 Parallel Ports

Port I/O Use Initial State
PAO-PA7 Output Configurable external 1/0 bus High \t/)v;?/nongzsdriven
PB0-PB1 Input Not used Pulled up on RCM3200
PB2-PB5 Input Configurable external 1/0 bus High \t/)v;??ontc:ltjgriven
PB6-PB7 Output Not used Pulled up on RCM3200

PCO Output Not used High (disabled)

PC1 Input Not used Pulled up on RCM3200

PC2 Output TXC High (disabled)

Serial Port C
PC3 Input RXC Pulled up on RCM3200
PC4 Output TXB High (disabled)
Serial Port B
PC5 Input RXB Pulled up on RCM3200
PC6 Output TXA Programming Port High (disabled)
Serial Port A

PC7 Input RXA Programming Port Pulled up on RCM3200

PDO Output Ethernet RSTDRV High

PD1 Input Not used Pulled up on RCM3200
PD2-PD4 Output Not used High

PD5 Input Not used ProFt)(l)J':i/T)(:nugpggar q
PD6-PD7 Output Not used High
PEO-PE1 Output Not used High

PE2 Output Ethernet chip select High

PE3 Output LCD device select Low (disabled)

PE4 Output IrDA speed select Low (disabled)

PES Output Not used High

PE6 Output External 1/O strobe High (disabled)

PE7 Output Not used High (disabled)
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Table B-2. RCM30/31/32XX Prototyping Board
Use of Rabbit 3000 Parallel Ports (continued)

Port I/O Use Initial State
Pulled up on
PFO-PF7 Input Reserved for future use Prototyping Board
PGO Input Switch S3 (normally open) High
PG1 Input Switch S2 (normally open) High
PG2 Output TXF IrDA Pulled down
Serial Port F
PG3 Input RXF IrDA Driven by IrDA driver
Pulled up on
PG4 Input IrDA MD1 Prototyping Board
Pulled down on
PG5 Input IrDA MDO Prototyping Board
PG6 Output LED DS1 High (disabled)
PG7 Output LED DS2 High (disabled)
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APPENDIX C. LCD/KEYPAD MODULE

An optional LCD/keypad is available for the Prototyping Board.
Appendix C describes the LCD/keypad and provides the soft-
ware APIs to make full use of the LCD/keypad.

C.1 Specifications

Two optional LCD/keypad modules—with or without a panel-mounted bezel—are available
for use with the Prototyping Board. They are shown in Figure C-1.

LCD/Keypad Modules

0®eeee00

- N+ Qe

Figure C-1. LCD/Keypad Modules Models

Contact your Z-World or Rabbit Semiconductor sales representative or your authorized
Z-World/Rabbit Semiconductor distributor for further assistance in purchasing an LCD/
keypad module.

Mounting hardware and a 60 cm (24") extension cable are also available for the LCD/key-
pad module through your Z-World/Rabbit Semiconductor sales representative or autho-
rized distributor.
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Table C-1 lists the electrical, mechanical, and environmental specifications for the LCD/

keypad module.

Table C-1. LCD/Keypad Specifications

Parameter Specification
. 2.60" x 3.00" x 0.75"
Board Size (66 mm x 76 mm x 19 mm)
Bezel Size 4.50" x 3.60" x 0.30"
(124 mm x 91 mm x 7.6 mm)
Operating Range: 0°C to +50°C
Temperature Storage Range: —40°C to +85°C
Humidity 5% to 95%, noncondensing

Power Consumption

1.5 W maximum”

Connections

Connects to high-rise header sockets on the Prototyping Board

LCD Panel Size

122 x 32 graphic display

Keypad

7-key keypad

LEDs

Seven user-programmable LEDs

* The backlight adds approximately 650 mW to the power consumption.

The LCD/keypad module has 0.1"
IDC headers at J1, J2, and J3 for Ll Lo.100

physical connection to other boards or
ribbon cables. Figure C-2 shows the
LCD/keypad module footprint. These
values are relative to one of the

mounting holes.
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(36.8)
2.200
(55.9)

Figure C-2. User Board Footprint for
LCD/Keypad Module
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C.2 Contrast Adjustments for All Boards

Depending on when you acquired your LCD/keypad module, you will be able to set the
contrast on the LCD display by adjusting the potentiometer at R2 or by setting the voltage
for 5 V by not using the jumper across any pins on header J5 as shown in Figure C-3. Only
one of these two options is available on a given LCD/keypad module.

LCD/Keypad Module Jumper Configurations

e Pins Factory
Header Description Connected Default
28V 12 X
75 33V 34
5V nc.
Contrast
T\

Adjustment [

"Om Om Om Om Om Om Om

R13 R14

Part No. 101-0541

DISPLAY
BOARD

O

Figure C-3. LCD/Keypad Module Voltage Settings

NOTE: Older LCD/keypad modules that do not have a header at J5 or a contrast adjust-
ment potentiometer at R2 are limited to operate only at 5 V, and will work with the
Prototyping Board. The older LCD/keypad modules are no longer being sold.
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C.3 Keypad Labeling

The keypad may be labeled according to your needs. A template is provided in Figure C-4
to allow you to design your own keypad label insert.

(28)

2.35
(60)

Figure C-4. Keypad Template

To replace the keypad legend, remove the old legend and insert your new legend prepared
according to the template in Figure C-4. The keypad legend is located under the blue key-
pad matte, and is accessible from the left only as shown in Figure C-5.

Keypad label is located

under the blue keypad matte. O Q000000 O

<JrRvl»
- N+ Q4

Figure C-5. Removing and Inserting Keypad Label

)
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C.4 Header Pinouts
Figure C-6 shows the pinouts for the LCD/keypad module.

J1

/ICS |v o|/RES

DB7B |o o | DB6B
+5BKLT (o m| VCC

DB5B | o o | DB4B
DB3B |o o | DB2B
DB1B |o o | DBOB
AOB [0 o|A1B

A2B [0 o|A3B

GND |o o | GND
GND |o o| LED7
LED6 |o o | LED5S
LED4 |o o | LED3
LED2 |o o | LED1

GND
DB6B
DB4B
DB2B
DBOB
AOB |Z ©| A1B

J3 J2

A2B |- B | A3B
PE7 |© = |/RES

GND | © | GND
+5BKLT |- ®|VvCC
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Figure C-6. LCD/Keypad Module Pinouts

C.4.1 1/O Address Assignments

The LCD and keypad on the LCD/keypad module are addressed by the /CS strobe as
explained in Table C-2.

Table C-2. LCD/Keypad Module Address Assignment

Address Function
0xCO000 Device select base address (/CS)
OXCxx0-0xCxx7 LCD control
OxCxx8 LED enable
0xCxx9 Not used
OXCxxA 7-key keypad
0xCxxB (bits 0-6) 7-LED driver
0xCxxB (bit 7) LCD backlight on/off
OXCxxC-ExxF Not used
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C.5 Mounting LCD/Keypad Module on the Prototyping Board

Install the LCD/keypad module on header sockets J7, J8, and J10 of the Prototyping Board
as shown in Figure C-7. Be careful to align the pins over the headers, and do not bend
them as you press down to mate the LCD/keypad module with the Prototyping Board.
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Figure C-7. Install LCD/Keypad Module on Prototyping Board
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C.6 Bezel-Mount Installation

This section describes and illustrates how to bezel-mount the LCD/keypad module. Fol-
low these steps for bezel-mount installation.

1. Cut mounting holes in the mounting panel in accordance with the recommended dimen-
sions in Figure C-8, then use the bezel faceplate to mount the LCD/keypad module onto

the panel.
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Figure C-8. Recommended Cutout Dimensions

2. Carefully “drop in” the LCD/keypad module with the bezel and gasket attached.
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3.

Fasten the unit with the four 4-40 screws and washers included with the LCD/keypad
module. If your panel is thick, use a 4-40 screw that is approximately 3/16" (5 mm)
longer than the thickness of the panel.

/7 Bezel/Gasket

Om Om OEN ON ON Om Om
FCUEMD20D 200 200 200 2Eg
Bl

Figure C-9. LCD/Keypad Module Mounted in Panel (rear view)

Carefully tighten the screws until the gasket is compressed and the plastic bezel face-
plate is touching the panel.

Do not tighten each screw fully before moving on to the next screw. Apply only one or
two turns to each screw in sequence until all are tightened manually as far as they can
be so that the gasket is compressed and the plastic bezel faceplate is touching the panel.
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C.6.1 Connect the LCD/Keypad Module to Your Prototyping Board

The LCD/keypad module can be located as far as 2 ft. (60 cm) away from the RCM30/31/
32XX Prototyping Board, and is connected via a ribbon cable as shown in Figure C-10.
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Figure C-10. Connecting LCD/Keypad Module to RCM30/31/32XX Prototyping Board

Note the locations and connections relative to pin 1 on both the Prototyping Board and the
LCD/keypad module.

Z-World offers 2 ft. (60 cm) extension cables. Contact your authorized Z-World distributor
or a Z-World sales representative at +1(530)757-3737 for more information.
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C.7 LCD/Keypad Module Function APIs

When mounted on the Prototyping Board, the LCD/keypad module uses the auxiliary 1/0
bus on the Rabbit 3000 chip. Remember to add the line

#define PORTA AUX IO

to the beginning of any programs using the auxiliary 1/0 bus.
C.7.1 LEDs

When power is applied to the LCD/keypad module for the first time, the red LED (DS1)
will come on, indicating that power is being applied to the LCD/keypad module. The red
LED is turned off when the brdInit function executes.

One function is available to control the LEDs, and can be found in the ReM3200.LIB
library in the saMPLES\RCM3200 directory.

void ledOut (int led, int wvalue);

LED on/off control. This function will only work when the LCD/keypad module is installed on the
Prototyping Board.

PARAMETERS
led is the LED to control.

0=LED DS1
1=LED DS2
2=LED DS3
3=LED DS4
4 =LED DS5
5=LED DS6
6 = LED DS7

value is the value used to control whether the LED is on or off (0 or 1).
0 = off
1l=o0n
RETURN VALUE
None.

SEE ALSO
brdInit
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C.7.2 LCD Display

The functions used to control the LCD display are contained in the GrRaAPHIC.LIB library
located in the Dynamic C p1sPLAYS\GRAPHIC library directory.

void glInit(void);

Initializes the display devices, clears the screen.

RETURN VALUE
None.

SEE ALSO
glDispOnOFF, glBacklight, glSetContrast, glPlotDot, glBlock, glPlotDot,
glPlotPolygon, glPlotCircle, glHScroll, glVScroll, glXFontInit, glPrintf,
glPutChar, glSetBrushType, glBufflLock, glBuffUnlock, glPlotLine

void glBackLight (int onOff) ;

Sets the intensity of the backlight, if circuitry is installed.

PARAMETER
onOf £ reflects the low to high values (typically 0 to 255, depending on the board design) to set the back-
light intensity (O will turn the backlight off completely.)

RETURN VALUE
None.

SEE ALSO
glInit, glDispOnoff, glSetContrast

void glDispOnOff (int onOff) ;

Sets the LCD screen on or off. Data will not be cleared from the screen.
PARAMETER
onOf £ turns the LCD screen on or off
1—turn the LCD screen on
O0—turn the LCD screen off

RETURN VALUE
None.

SEE ALSO
glInit, glSetContrast, glBackLight
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void glSetContrast (unsigned level) ;

Sets display contrast (the circuitry is not installed on the LCD/keypad module used with the Prototyping
Board).

PARAMETER
level reflects low to high values (typically 0 to 255, depending on the board design) to give high to low
contrast respectively.

RETURN VALUE
None.

SEE ALSO
glInit, glBacklight, glDispOnoff

void glFillScreen (char pattern);

Fills the LCD display screen with a pattern.

PARAMETER
The screen will be set to all black if pattern is OXFF, all white if pattern is 0x00, and vertical stripes
for any other pattern.

RETURN VALUE
None.

SEE ALSO
glBlock, glBlankScreen, glPlotPolygon, glPlotCircle

void glBlankScreen (void) ;

Blanks the LCD display screen (sets LCD display screen to white).

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlock, glPlotPolygon, glPlotCircle
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void glBlock(int x, int y, int bmWidth,
int bmHeight) ;

Draws a rectangular block in the page buffer and on the LCD if the buffer is unlocked. Any portion of the
block that is outside the LCD display area will be clipped.

PARAMETERS
x is the x coordinate of the upper left corner of the block.
y is the y coordinate of the left top corner of the block.
bmWidth is the width of the block.
bmWidth is the height of the block.

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlankScreen, glPlotPolygon, glPlotCircle

void glPlotVPolygon (int n, int *pFirstCoord) ;

Plots the outline of a polygon in the LCD page buffer, and on the LCD if the buffer is unlocked. Any por-
tion of the polygon that is outside the LCD display area will be clipped. The function will also return,
doing nothing, if there are less than 3 vertices.

PARAMETERS
n is the number of vertices.
*pFirstCoord is a pointer to array of vertex coordinates: x1,y1, x2,y2, x3,y3,..

RETURN VALUE
None.

SEE ALSO
glPlotPolygon, glFillPolygon, glFillVPolygon
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void glPlotPolygon(int n, int yl, int x2, int y2,
o o o ) ;
Plots the outline of a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any por-

tion of the polygon that is outside the LCD display area will be clipped. The function will also return,
doing nothing, if there are less than 3 vertices.

PARAMETERS
n is the number of vertices.
y1 is the y coordinate of the first vertex.
x1 is the x coordinate of the first vertex.
y2 is the y coordinate of the second vertex.
x2 is the x coordinate of the second vertex.
. . . are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
glPlotVPolygon, glFillPolygon, glFillVPolygon

void glFillVPolygon(int n, int #*pFirstCoord) ;

Fills a polygon in the LCD page buffer and on the LCD screen if the buffer is unlocked. Any portion of
the polygon that is outside the LCD display area will be clipped. The function will also return, doing
nothing, if there are less than 3 vertices.

PARAMETERS
n is the number of vertices.
*pFirstCoord is a pointer to array of vertex coordinates: x1,y1l, x2,y2, x3,y3,...

RETURN VALUE
None.

SEE ALSO
glFillPolygon, glPlotPolygon, glPlotVPolygon
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void glFillPolygon(int n, int x1, int y1l, int x2,
int Y2 , e e e ) ;
Fills a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the poly-
gon that is outside the LCD display area will be clipped.

PARAMETERS
n is the number of vertices.

x1 is the x coordinate of the first vertex.
y1is the y coordinate of the first vertex.

x2 is the x coordinate of the second vertex.
y2 is the y coordinate of the second vertex.

. . . are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
glFillVPolygon, glPlotPolygon, glPlotVPolygon

void glPlotCircle(int xc, int yc, int rad);

Draws a circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the circle
that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.

ye is the y coordinate of the center of the circle.
rad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glFillCircle, glPlotPolygon, glFillPolygon

void glFillCircle(int xc, int yc, int rad):;

Draws a filled circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.

ye is the y coordinate of the center of the circle.
rad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glPlotCircle, glPlotPolygon, glFillPolygon
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void glXFontInit (fontInfo *pInfo, char pixWidth,
char pixHeight, unsigned startChar,
unsigned endChar, unsigned long xmemBuffer) ;

Initializes the font descriptor structure, where the font is stored in xmem. Each font character's bitmap is
column major and byte-aligned.

PARAMETERS
*pInfo is a pointer to the font descriptor to be initialized.
pixwWidth is the width (in pixels) of each font item.
pixHeight is the height (in pixels) of each font item.
startChar is the value of the first printable character in the font character set.
endChar is the value of the last printable character in the font character set.
xmemBuf fer is the xmem pointer to a linear array of font bitmaps.

RETURN VALUE

None.

SEE ALSO
glPrinf

unsigned long glFontCharAddr (fontInfo *pInfo,
char letter);

Returns the xmem address of the character from the specified font set.
PARAMETERS

*pInfo is the xmem address of the bitmap font set.

letter is an ASCII character.
RETURN VALUE

xmem address of bitmap character font, column major, and byte-aligned.

SEE ALSO
glPutFont, glPrintf
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void glPutFont (int x, int y, fontInfo *pInfo,
char code) ;
Puts an entry from the font table to the page buffer and on the LCD if the buffer is unlocked. Each font

character's bitmap is column major and byte-aligned. Any portion of the bitmap character that is outside
the LCD display area will be clipped.

PARAMETERS
x is the x coordinate (column) of the upper left corner of the text.
y is the y coordinate (row) of the left top corner of the text.
*pInfo is a pointer to the font descriptor.
code is the ASCII character to display.

RETURN VALUE
None.

SEE ALSO
glFontCharAddr, glPrintf

void glSetPfStep(int stepX, int stepY):;

Setsthe glPrint£ () printing step direction. The x and y step directions are independent signed values.
The actual step increments depend on the height and width of the font being displayed, which are multi-
plied by the step values.

PARAMETERS
stepX isthe glPrintf x step value

stepY isthe glPrint£ y step value

RETURN VALUE
None.

SEE ALSO
Use glGetP£fStep () to examine the current x and y printing step direction.

int glGetPfStep(void) ;

Gets the current glPrint £ () printing step direction. Each step direction is independent of the other,
and is treated as an 8-bit signed value. The actual step increments depends on the height and width of the
font being displayed, which are multiplied by the step values.

RETURN VALUE
The x step is returned in the MSB, and the y step is returned in the LSB of the integer result.

SEE ALSO
Use glGetP£fStep () to control the x and y printing step direction.
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void glPutChar (char ch, char *ptr, int *cnt,
glPutCharInst *plInst)
Provides an interface between the STDIO string-handling functions and the graphic library. The
STDIO string-formatting function will call this function, one character at a time, until the entire format-

ted string has been parsed. Any portion of the bitmap character that is outside the LCD display area will
be clipped.

PARAMETERS
ch is the character to be displayed on the LCD.

*ptr is not used, but is a place holder for STDIO string functions.
*cnt is not used, is a place holder for STDIO string functions.
*pInst is a font descriptor pointer.

RETURN VALUE
None.

SEE ALSO
glPrintf, glPutFont, doprnt

void glPrintf (int x, int y, fontInfo *pInfo,
char *fmt, ...);

Prints a formatted string (much like print£) on the LCD screen. Only the character codes that exist in
the font set are printed, all others are skipped. For example, \b', \t', \n' and '\r' (ASCII backspace, tab,
new line, and carriage return, respectively) will be printed if they exist in the font set, but will not have
any effect as control characters. Any portion of the bitmap character that is outside the LCD display area
will be clipped.

PARAMETERS
x is the x coordinate (column) of the upper left corner of the text.

y is the y coordinate (row) of the upper left corner of the text.
*pInfo is a font descriptor pointer.

*£mt is a formatted string.

. . . are formatted string conversion parameter(s).

EXAMPLE
glprintf (0,0, &£fil2x16, "Test %d\n", count);

RETURN VALUE
None.

SEE ALSO
glXFontInit
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void glBufflock (void) ;

Increments LCD screen locking counter. Graphic calls are recorded in the LCD memory buffer and are
not transferred to the LCD if the counter is non-zero.

NOTE: glBuffLock() and glBuffUnlock () can be nested up to a level of 255, but be
sure to balance the calls. It is not a requirement to use these procedures, but a set of
glBuffLock () and glBuffUnlock () bracketing a set of related graphic calls speeds
up the rendering significantly.

RETURN VALUE
None.

SEE ALSO
glBuffUnlock, glSwap

void glBuffUnlock(void) ;

Decrements the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD
if the counter goes to zero.

RETURN VALUE
None.

SEE ALSO
glBuffLock, glSwap

void glSwap (void) ;

Checks the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD if the
counter is zero.

RETURN VALUE
None.

SEE ALSO

glBuffUnlock, glBuffLock, glSwapData (located in the library specifically for the LCD
that you are using)

void glSetBrushType (int type);

Sets the drawing method (or color) of pixels drawn by subsequent graphic calls.
PARAMETER
type value can be one of the following macros.

PIXBLACK draws black pixels.
PIXWHITE draws white pixels.
PIXXOR draws old pixel XOR'ed with the new pixel.
RETURN VALUE
None.

SEE ALSO
glGetBrushType
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int glGetBrushType (void) ;

Gets the current method (or color) of pixels drawn by subsequent graphic calls.

RETURN VALUE
The current brush type.

SEE ALSO
glSetBrushType

void glPlotDot (int x, int y);

Draws a single pixel in the LCD buffer, and on the LCD if the buffer is unlocked. If the coordinates are

outside the LCD display area, the dot will not be plotted.

PARAMETERS
x is the x coordinate of the dot.
y is the y coordinate of the dot.

RETURN VALUE
None.

SEE ALSO
glPlotline, glPlotPolygon, glPlotCircle

void glPlotLine(int x0, int yO,

int x1,

int y1);

Draws a line in the LCD buffer, and on the LCD if the buffer is unlocked. Any portion of the line that is

beyond the LCD display area will be clipped.
PARAMETERS

x0 is the x coordinate of one endpoint of the line.

y0 is the y coordinate of one endpoint of the line.

x1 is the x coordinate of the other endpoint of the line.

y1 is the y coordinate of the other endpoint of the line.

RETURN VALUE
None.

SEE ALSO
glPlotDot, glPlotPolygon, glPlotCircle
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void glLeftl (int left, int top, int cols, int rows);

Scrolls byte-aligned window left one pixel, right column is filled by current pixel type (color).

PARAMETERS
left is the upper left corner of bitmap, must be evenly divisible by 8.

top is the left top corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glHScroll, glRightl

void glRightl (int left, int top, int cols, int rows);

Scrolls byte-aligned window right one pixel, left column is filled by current pixel type (color).

PARAMETERS
left is the upper left corner of bitmap, must be evenly divisible by 8.
top is the left top corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glHScroll, glLeftl

void glUpl(int left, int top, int cols, int rows);

Scrolls byte-aligned window up one pixel, bottom column is filled by current pixel type (color).

PARAMETERS
left is the upper left corner of bitmap, must be evenly divisible by 8.
top is the left top corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glvScroll, glDownl
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void glDownl (int left, int top, int cols, int rows);
Scrolls byte-aligned window down one pixel, top column is filled by current pixel type (color).

PARAMETERS
left is the upper left corner of bitmap, must be evenly divisible by 8.
top is the left top corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glvScroll, glUpl

void glHScroll (int left, int top, int cols,
int rows, int nPix);

Scrolls right or left, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. The left and cols parameters will be verified that they are evenly divisible by 8. If not, they will
be changed to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.

PARAMETERS
left is the upper left corner of bitmap, must be evenly divisible by 8.
top is the left top corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.
nPix is the number of pixels to scroll within the defined window (a negative value will produce a scroll
to the left).

RETURN VALUE
None.

SEE ALSO
glvScroll
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void glVScroll (int left, int top, int cols,
int rows, int nPix);
Scrolls up or down, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.
Parameters will be verified for the following:

1. The 1eft and cols parameters will be verified that they are evenly divisible by 8. If not, they will
be changed to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.
PARAMETERS
left is the upper left corner of bitmap, must be evenly divisible by 8.
top is the left top corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.
nPix is the number of pixels to scroll within the defined window (a negative value will produce a scroll
up).
RETURN VALUE

None.

SEE ALSO
glHScroll

void glXPutBitmap (int left, int top, int width,
int height, unsigned long bitmap) ;

Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function calls

glXPutFastmap automatically if the bitmap is byte-aligned (the left edge and the width are each

evenly divisible by 8).

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.
PARAMETERS

left is the upper left corner of the bitmap.

top is the upper left corner of the bitmap.

width is the width of the bitmap.

height is the height of the bitmap.

bitmap is the address of the bitmap in xmem.

RETURN VALUE
None.

SEE ALSO
glXPutFastmap, glPrintf
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void glXPutFastmap(int left, int top, int width,
int height, unsigned long bitmap);
Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function is like
glXPutBitmap, except that it is faster. The restriction is that the bitmap must be byte-aligned.
Any portion of a bitmap image or character that is outside the LCD display area will be clipped.
PARAMETERS
left is the upper left corner of the bitmap, must be evenly divisible by 8.
top is the upper left corner of the bitmap.
width is the width of the bitmap, must be evenly divisible by 8.
height is the height of the bitmap.
bitmap is the address of the bitmap in xmem.

RETURN VALUE
None.

SEE ALSO
glXPutBitmap, glPrintf

int TextWindowFrame (windowFrame *window,
fontInfo *pFont, int x, int y, int winWidth,
int winHeight)

Defines a text-only display window. This function provides a way to display characters within the text
window using only character row and column coordinates. The text window feature provides end-of-line
wrapping and clipping after the character in the last column and row is displayed.

NOTE: Execute the TextWwindowFrame function before other Text. .. functions.

PARAMETERS

*window is a window frame descriptor pointer.

*pFont is a font descriptor pointer.

x is the x coordinate of where the text window frame is to start.

y is the y coordinate of where the text window frame is to start.

winWidth is the width of the text window frame.

winHeight is the height of the text window frame.
RETURN VALUE

0—window frame was successfully created.

-1—x coordinate + width has exceeded the display boundary.
-2—y coordinate + height has exceeded the display boundary.
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volid TextGotoXY (windowFrame *window, int col,
int row) ;

Sets the cursor location on the display of where to display the next character. The display location is
based on the height and width of the character to be displayed.

NOTE: Execute the TextWwindowFrame function before using this function.

PARAMETERS
*window is a pointer to a font descriptor.

col is a character column location.
row is a character row location.

RETURN VALUE
None.

SEE ALSO
TextPutChar, TextPrintf, TextWindowFrame

volid TextCursorl.ocation (windowFrame *window,
int *col, int *row);

Gets the current cursor location that was set by a Graphic Text. . . function.

NOTE: Execute the TextWwindowFrame function before using this function.
PARAMETERS
*window is a pointer to a font descriptor.
*col is a pointer to cursor column variable.
*row IS a pointer to cursor row variable.

RETURN VALUE
Lower word = Cursor Row location
Upper word = Cursor Column location

SEE ALSO

TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation

void TextPutChar (struct windowFrame *window, char ch);

Displays a character on the display where the cursor is currently pointing. If any portion of a bitmap
character is outside the LCD display area, the character will not be displayed.

NOTE: Execute the TextwindowFrame function before using this function.

PARAMETERS
*window is a pointer to a font descriptor.
ch is a character to be displayed on the LCD.

RETURN VALUE
None.

SEE ALSO
TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation
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void TextPrintf (struct windowFrame *window,
char *fmt, ...);
Prints a formatted string (much like print £) on the LCD screen. Only printable characters in the font
set are printed, also escape sequences, "\r' and "\n' are recognized. All other escape sequences will be

skipped over; for example, \b" and 't' will print if they exist in the font set, but will not have any effect as
control characters.

The text window feature provides end-of-line wrapping and clipping after the character in the last col-
umn and row is displayed.
NOTE: Execute the TextwindowFrame function before using this function.
PARAMETERS
*window is a pointer to a font descriptor.
*£mt is a formatted string.

. . . are formatted string conversion parameter(s).

EXAMPLE
TextPrintf (&TextWindow, "Test %d\n", count);

RETURN VALUE
None.

SEE ALSO
TextGotoXY, TextPutChar, TextWindowFrame, TextCursorLocation
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C.7.3 Keypad

The functions used to control the keypad are contained in the KEYPAD7 . LIB library
located in the Dynamic C kEYPADS library directory.

void keyInit (void);

Initializes keypad process

RETURN VALUE
None.

SEE ALSO
brdInit

void keyConfig(char cRaw, char cPress,
char cRelease, char cCntHold, char cSpdLo,
char cCntLo, char cSpdHi) ;

Assigns each key with key press and release codes, and hold and repeat ticks for auto repeat and
debouncing.

PARAMETERS
cRaw is a raw key code index.

1x7 keypad matrix with raw key code index assignments (in brackets):

[0] [1] (2] (3]
[4] [5] (6]

User Keypad Interface
cPress is a key press code

An 8-bit value is returned when a key is pressed.
0 = Unused.

See keypadDef () for default press codes.
cRelease is a key release code.

An 8-bit value is returned when a key is pressed.
0 = Unused.

cCntHold is a hold tick.

How long to hold before repeating.
0 = No Repeat.

cSpdLo is a low-speed repeat tick.

How many times to repeat.
0 = None.

cCntLo is a low-speed hold tick.

How long to hold before going to high-speed repeat.
0 = Slow Only.
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cSpdHi is a high-speed repeat tick.

How many times to repeat after low speed repeat.
0 = None.

RETURN VALUE
None.

SEE ALSO
keyProcess, keyGet, keypadDef

Scans and processes keypad data for key assignment, debouncing, press and release, and repeat.

NOTE: This function is also able to process an 8 x 8 matrix keypad.

RETURN VALUE
None

SEE ALSO
keyConfig, keyGet, keypadDef

Get next keypress

RETURN VALUE
The next keypress, or 0 if none

SEE ALSO
keyConfig, keyProcess, keypadDef

Push keypress on top of input queue

PARAMETER
cKey

RETURN VALUE
None.

SEE ALSO
keyGet
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void keypadDef () ;

Configures the physical layout of the keypad with the desired ASCII return key codes.

Keypad physical mapping 1 x 7

0 4 1 5 2 6 3
[L1] (U] [D] [R1]
[-] [+] [E]
where

'E' represents the ENTER key
'D' represents Down Scroll

'U' represents Up Scroll

'R’ represents Right Scroll
'L represents Left Scroll

Example: Do the followingfor the above physical vs. ASCII return key codes.

keyConfig
keyConfig
keyConfig
keyConfig
keyConfig
keyConfig
keyConfig

~ e~~~ o~~~

3,'R',
6,'E',
2,'D',

0, 0,
0, 0,
0, 0,

4,'-',0, 0O,
i,'w',0, O,
5,'+',0, O,
o,'n',0, O,

0,
0,
0,

0,
0,
0,

0);
0);
) ;
) ;
)
)
)

O O O o o

Characters are returned upon keypress with no repeat.

RETURN VALUE
None.

SEE ALSO
keyConfig,

keyGet,

keyProcess

void keyScan(char *pcKeys) ;

Writes "1" to each row and reads the value. The position of a keypress is indicated by a zero value in a bit

position.
PARAMETER

*pcKeys is the address of the value read.

RETURN VALUE
None.

SEE ALSO
keyConfig,

keyGet,

keypadDef,

keyProcess
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C.8 Sample Programs

Sample programs illustrating the use of the LCD/keypad module with the Prototyping
Board are provided in the sSAMPLES\RCM3200 directory.

These sample programs use the auxiliary 1/0 bus on the Rabbit 3000 chip, and so the
#define PORTA AUX IO lineis already included in the sample programs.

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program. To run a sample
program, open it with the File menu (if it is not still open), compile it using the Compile
menu, and then run it by selecting Run in the Run menu. The RCM3200 must be in
Program mode (see Section 3.3, “Programming Cable”), and must be connected to a PC
using the programming cable as described in the RCM3200 Getting Started Manual.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
The following sample programs are found in the SAMPLES\RCM3200\LCD KEYPAD folder.

e KEYPADTOLED.C—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a key press is detected. The DS1 and DS2 LEDs on the Prototyping
Board will also light up.

® LCDKEYFUN.C—This program demonstrates how to draw primitive features from the
graphic library (lines, circles, polygons), and also demonstrates the keypad with the key
release option.

e SWITCHTOLED.C—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a switch press is detected. The DS1 and DS2 LEDs on the Prototyp-
ing Board will also light up.
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APPENDIX D. POWER SUPPLY

Appendix D provides information on the current requirements
of the RCM3200, and includes some background on the chip
select circuit used in power management.

D.1 Power Supplies

The RCM3200 requires a regulated 3.3 V = 0.15 V DC power source. The RabbitCore
design presumes that the voltage regulator is on the user board, and that the power is made
available to the RCM3200 board through header J2.

An RCM3200 with no loading at the outputs operating at 29.4 MHz typically draws 145 mA.
The RCM3200 will consume an additional 10 mA when the programming cable is used to
connect the programming header, J3, to a PC.

D.1.1 Battery-Backup Circuits

The RCM3200 does not have a battery, but there is provision for a customer-supplied bat-
tery to back up the data SRAM and keep the internal Rabbit 3000 real-time clock running.

Header J2, shown in Figure D-1, allows access to the external battery. This header makes
it possible to connect an external 3 V power supply. This allows the SRAM and the inter-
nal Rabbit 3000 real-time clock to retain data with the RCM3200 powered down.

External
J2 Battery
VRAM 29 /\/30 VBAT_EXT |./

|
+3.3V 31 O O 32 GND J

Figure D-1. External Battery Connections
at Header J5

A lithium battery with a nominal voltage of 3 V and a minimum capacity of 165 mA:h is
recommended. A lithium battery is strongly recommended because of its nearly constant
nominal voltage over most of its life.
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The drain on the battery by the RCM3200 is typically 12 pA when no other power is sup-
plied. If a 165 mA-h battery is used, the battery can last almost 2 years:

165 mA-h

2 iA = 1.6 years.

The actual life in your application will depend on the current drawn by components not on
the RCM3200 and the storage capacity of the battery. Note that the shelf life of a lithium ion
battery is ultimately 10 years. The RCM3200 does not drain the battery while it is powered
up normally.

D.1.2 Reset Generator

The RCM3200 uses a reset generator to reset the Rabbit 3000 microprocessor when the volt-
age drops below the voltage necessary for reliable operation. The reset occurs between
2.85V and 3.00 V, typically 2.93 V. The RCM3200 has a reset output, pin 1 on header J2.

D.2 Optional +5 V Output

The RCM3200 boards have an onboard charge pump that provides the +5 V needed by the
RealTek Ethernet chip.
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APPENDIX E. MOTOR CONTROL OPTION

The Prototyping Board has a header at J6 for a motor control option.
While Z-World and Rabbit Semiconductor do not support this option
at this time, this appendix provides additional information about Paral-
lel Port F on the Rabbit 3000 microprocessor to enable you to use this
feature on the Prototyping Board for your needs.

E.1 Overview

The Parallel Port F connector on the Prototyping Board, J6, gives access to all 8 pins of
Parallel Port F, along with +5 V. This appendix describes the function of each pin, and the
ways they may be used for motion-control applications. It should be read in conjunction
with the Rabbit 3000 Microprocessor User’s Manual and the RCM3200 and the Proto-

typing Board schematics.
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E.2 Header J6

The connector isa 2 x 5, 0.1" pitch header suitable for connecting to a IDC receptacle,
with the following pin allocations.

Table E-1. Prototyping Board Header J6 Pinout

Pin Rabbit 3000 Primary Function | Alternate Function 1 | Alternate Function 2

Quadrature decoder 1 Q

1 Parallel Port F, bit 0 | General-purpose 1/0 port input

SCLK_D

Quadrature decoder 1 |

2 Parallel Port F, bit 1 | General-purpose 1/0 port input

SCLK_C

Quadrature decoder 2 Q

3 Parallel Port F, bit2 | General-purpose 1/0 port input

4 Parallel Port F, bit 3 | General-purpose 1/0 port i(?]:i(zrature decoder 21 | _

Quadrature decoder 1 Q

5 Parallel Port F, bit 4 | General-purpose 1/0O port | PWMI0] output input

Quadrature decoder 1 |

6 Parallel Port F, bit5 | General-purpose 1/0O port | PWM[1] output input

Quadrature decoder 2 Q

7 Parallel Port F, bit 6 | General-purpose 1/O port | PWM[2] output input

Quadrature decoder 2 |

8 Parallel Port F, bit 7 | General-purpose 1/0O port | PWM[3] output input

9 +5V External buffer logic supply

10 ov Common

All Parallel Port F lines (pins 1 to 8) are pulled up internally to +3.3 V via 100 kQ resis-
tors. When used as outputs, the port pins will sink up to 6 mA at a Vg, of 0.4 V max.

(0.2 V typ), and source up to 6 mA at a Vg of 2.2 V typ. When used as inputs, all pins
are 5 V tolerant.

As the outputs from Parallel Port F are compatible with 3.3 V logic, buffers may be
needed when the external circuit drive requirements exceed the 2.2 V typ logic high and/or
the 6 mA maximum from the Rabbit 3000. The +5 V supply output is provided for supply-
ing interface logic. When used as inputs, the pins on header J6 do not require buffers
unless the input voltage will exceed the 5 V tolerance of the processor pins. Usually, a
simple resistive divider with catching diodes will suffice if higher voltage inputs are
required. If the outputs are configured for open-drain operation, they may be pulled up to
+5 V (while observing the maximum current, of course).
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E.3 Using Parallel Port F

Parallel Port F is a byte-wide port with each bit programmable for data direction and drive.
These are simple inputs and outputs controlled and reported in the Port F Data Register.
As outputs, the bits of the port are buffered, with the data written to the Port F Data Regis-
ter transferred to the output pins on a selected timing edge. The outputs of Timer Al,
Timer B1, or Timer B2 can be used for this function, with each nibble of the port having a
separate select field to control this timing. These inputs and outputs are also used for
access to other peripherals on the chip.

As outputs, Parallel Port F can carry the four Pulse Width Modulator outputs on PF4-PF 7
(J6, pins 5-8). As inputs, Parallel Port F can carry the inputs to the Quadrature Decoders
on PFO-PF3 (J6, pins 1-4). When Serial Port C or Serial Port D is used in clocked serial
mode, two pins of Port F (PFO / J6:1 and PF1/ J6:2) are used to carry the serial clock sig-
nals. When the internal clock is selected in these serial ports, the corresponding bit of Par-
allel Port F is set as an output.

E.3.1 Parallel Port F Registers

Data Direction Register—PFDDR, address 00111111 (0x3F), write-only, default value on
reset 00000000. For each bit position, write a 1 to make the corresponding port line an
output, or 0 to produce an input.

Drive Control Register—PFDCR, address 00111110 (0x3E), Write-only, no default on
reset (port defaults to all inputs). Effective only if the corresponding port bits are set as
outputs, each bit set to 1 configures the corresponding port bit as open drain. Setting the
bit to 0 configures that output as active high or low.

Function Register—PFFR, address 00111101 (0x3D), Write-only, no default on reset.
This register sets the alternate output function assigned to each of the pins of the port.
When set to 0, the corresponding port pin functions normally as an output (if configured to
be an output in PFDDR). When set to 1, each bit sets the corresponding pin to have the
alternate output function as shown in the summary table at the end of this section.

Control Register—PFCR, address 00111100 (0x3C), Write-only, default on reset
xx00xx00. This register sets the transfer clock, which controls the timing of the outputs on
each nibble of the output ports to allow close synchronization with other events. The sum-
mary table at the end of this section shows the settings for this register. The default values
on reset transfer the output values on CLK/2.

Data Register—PFDR, address 00111000 (0x38), Read or Write, no default value on
reset. On read, the current state of the pins is reported. On write, the output buffer is writ-
ten with the value for transfer to the output port register on the next rising edge of the
transfer clock, set in the PFCR.
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Table E-2. Parallel Port F Registers

Register Name Mnemonic I/O Address R/W Reset Value
Port F Data Register PFDR 00111000 (0x38) R/W XXXXXXXX
Bits Value Description
0:7 Read Current state of pins
Write P_o_rt buffer. Value transferred to O/P register on next
rising edge of transfer clock.
Port F Control Register PFCR 00111100 (0x3C) |W only xx00xx00
Bits Value Description
0:1 00 Lower nibble transfer clock is CLK/2
01 Lower nibble transfer clock is Timer Al
10 Lower nibble transfer clock is Timer B1
1 Lower nibble transfer clock is Timer B2
2:3 XX These bits are ignored
4:5 00 Upper nibble transfer clock is CLK/2
01 Upper nibble transfer clock is Timer Al
10 Upper nibble transfer clock is Timer B1
11 Upper nibble transfer clock is Timer B2
6:7 XX These bits are ignored
Port F Function Register PFFR 00111101 (0x3D) |W XXXXXXXX
Bits Value Description
0:7 0 Corresponding port bits function normally
0 1 Bit O carries SCLK_D
1 1 Bit 1 carries SCLK_C
2:3 X No effect
4 1 Bit 4 carries PWMIJ0] output
5 1 Bit 5 carries PWMI[1] output
6 1 Bit 6 carries PWM][2] output
7 1 Bit 7 carries PWM][3] output
Port F Drive Control Register PFDCR 00111110 (OX3E) |W XXXXXXXX
Bits Value Description
0:7 0 Corresponding port bit is active high or low
1 Corresponding port bit is open drain
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Table E-2. Parallel Port F Registers (continued)

Register Name Mnemonic I/O Address R/W Reset Value
Port F Data Direction Register PFDDR 00111111 (Ox3F) W 00000000
Bits Value Description
0:7 0 Corresponding port bit is an input
1 Corresponding port bit is an output
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E.4 PWM Outputs

The Pulse-Width Modulator consists of a 10-bit free-running counter and four width regis-
ters. Each PWM output is high for n + 1 counts out of the 1024-clock count cycle, where n
is the value held in the width register. The PWM output high time can optionally be spread
throughout the cycle to reduce ripple on the externally filtered PWM output. The PWM is
clocked by the output of Timer A9. The spreading function is implemented by dividing
each 1024-clock cycle into four quadrants of 256 clocks each. Within each quadrant, the
Pulse-Width Modulator uses the eight MSBs of each pulse-width register to select the base
width in each of the quadrants. This is the equivalent to dividing the contents of the pulse-
width register by four and using this value in each quadrant. To get the exact high time, the
Pulse-Width Modulator uses the two LSBs of the pulse-width register to modify the high
time in each quadrant according to Table E-3 below. The “n/4” term is the base count, and
is formed from the eight MSBs of the pulse-width register.

Table E-3. PWM Outputs

Pulse Width LSBs 1st 2nd 3rd 4th
00 n/4+1 n/4 n/4 n/4
01 n/4 +1 n/4 n/4 +1 n/4
10 n/4+1 n/4+1 n/4+1 n/4
11 n/4+1 n/4+1 n/4+1 n/4+1

The diagram below shows a PWM output for several different width values for both
modes of operation. Operation in the spread mode reduces the filtering requirements on
the PWM output in most cases.

n=255, normal

(256 counts)

n:25515pread (64 counts) (64 counts) (64 counts) (64 counts)

(65 counts)

(64 counts) (64 counts) (64 counts)

n=256, spread |

[ ] [ ] [ ]

[ ] [ ] [ ]
n:257,spre£_| (65 counts) _| (64 counts) _l (65 counts)

[ ] [ ] [ ]

[ ] [ ] [ ]

(64 counts)

n=258, spread

(65 counts) (65 counts) (65 counts) (64 counts)

JJ 13

n:25975pread (65 counts) (65 counts) (65 counts) (65 counts)

n=259, normal

| (260 counts)

Figure E-1. PWM Outputs for Various Normal and Spread Modes
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E.5 PWM Registers

There are no default values on reset for any of the PWM registers.

Table E-4. PWM Registers

PWM LSBs Register Address
PWLOR 10001000 (0x88)
PWLI1R 10001010 (0x8A)
PWL2R 10001100 (0x8C)
PWL3R 10001110 (OX8E)
Bit(s) Value Description
76 Write The least significant two bits for the Pulse Width Modulator count are
stored
5:1 These bits are ignored.
0 0 PWM output High for single block.
1 Spread PWM output throughout the cycle
PWM MSB x | Register Address
PWMOR Address = 10001001 (0x89)
PWMIR Address = 10001011 (0x8B)
PWM2R Address = 10001101 (0x8D)
PWM3R Address = 10001111 (0x8F)
Bit(s) Value Description
The most significant eight bits for the Pulse-Width Modulator count
70 write are stored

With a count of n, the PWM output will be high for n +1 clocks out of
the 1024 clocks of the PWM counter.
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E.6 Quadrature Decoder

The two-channel Quadrature Decoder accepts inputs via Parallel Port F from two external
optical incremental encoder modules. Each channel of the Quadrature Decoder accepts an
in-phase (1) and a quadrature-phase (Q) signal, and provides 8-bit counters to track shaft
rotation and provide interrupts when the count goes through the zero count in either direc-
tion. The Quadrature Decoder contains digital filters on the inputs to prevent false counts
and is clocked by the output of Timer A10. Each Quadrature Decoder channel accepts
inputs from either the upper nibble or lower nibble of Parallel Port F. The I signal is input
on an odd-numbered port bit, while the Q signal is input on an even-numbered port bit.
There is also a disable selection, which is guaranteed not to generate a count increment or
decrement on either entering or exiting the disable state. The operation of the counter as a
function of the I and Q inputs is shown below.

}nterrupt

Figure E-2. Operation of Quadrature Decoder Counter

The Quadrature Decoders are clocked by the output of Timer A10, giving a maximum
clock rate of one-half of the peripheral clock rate. The time constant of Timer A10 must be
fast enough to sample the inputs properly. Both the I and Q inputs go through a digital fil-
ter that rejects pulses shorter than two clock periods wide. In addition, the clock rate must
be high enough that transitions on the | and Q inputs are sampled in different clock cycles.
The Input Capture (see the Rabbit 3000 Microprocessor Users Manual) may be used to
measure the pulse width on the | inputs because they come from the odd-numbered port
bits. The operation of the digital filter is shown below.

e /
pospied \____\ /
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The Quadrature Decoder generates an interrupt when the counter increments from 0x00 to
0x01 or when the counter decrements from 0x00 to OXFF. Note that the status bits in the
QDCSR are set coincident with the interrupt, and the interrupt (and status bits) are cleared

by reading the QDCSR.

Table E-5. Quadrature Decoder Registers

Register Name Mnemonic Address
Quaq Decode Control/Status QDCSR 10010000 (0x90)
Register
Bit Value Description
7 . .
0 Quadrature Decoder 2 did not increment from OXFF.
(rd-only)
1 Quadrature Decoder 2 incremented from OXFF to
0x00. This bit is cleared by a read of this register.
6
0 Quadrature Decoder 2 did not decrement from 0x00.
(rd-only)
1 Quadrature Decoder 2 decremented from 0x00 to
OxFF. This bit is cleared by a read of this register
5 0 This bit always reads as zero.
4
0 No effect on the Quadrature Decoder 2.
(wr-only)
1 Reset Quadrature Decoder 2 to 0x00, without
causing an interrupt.
3 . .
0 Quadrature Decoder 1 did not increment from OxFF.
(rd-only)
1 Quadrature Decoder 1 incremented from OxFF to
0x00. This bit is cleared by a read of this register.
2 .
0 Quadrature Decoder 1 did not decrement from 0x00.
(rd-only)
1 Quadrature Decoder 1 decremented from 0x00 to
OxFF. This bit is cleared by a read of this register.
1 0 This bit always reads as zero.
Bit Value Description
0
0 No effect on the Quadrature Decoder 1.
(wr-only)
1 Reset Quadrature Decoder 1 to 0x00, without
causing an interrupt.
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Table E-5. Quadrature Decoder Registers (continued)

Register Name Mnemonic Address
QU (B2l G QDCR Address = 10010001 (0x91)
Register
Bit Value Description

Disable Quadrature Decoder 2 inputs. Writing a new
7:6 0x value to these bits will not cause Quadrature
Decoder 2 to increment or decrement.

Quadrature Decoder 2 inputs from Port F bits 3 and

10 5
1 Quadrature Decoder 2 inputs from Port F bits 7 and
6.
5:4 XX These bits are ignored.

Disable Quadrature Decoder 1 inputs. Writing a new
3:2 0x value to these bits will not cause Quadrature
Decoder 1 to increment or decrement.

Quadrature Decoder 1 inputs from Port F bits 1 and

10 0
1 Quadrature Decoder 1 inputs from Port F bits 5 and
4,
1.0 0 Quadrature Decoder interrupts are disabled.
1 Quadrature Decoder interrupt use Interrupt Priority
1.
10 Quadrature Decoder interrupt use Interrupt Priority
2.
1 Quadrature Decoder interrupt use Interrupt Priority
3.
Quad Decode Count Register | QDC1R Address = 10010100 (0x94)

(QDC2R) Address = 10010110 (0x96)

Bit(s) Value Description

The current value of the Quadrature Decoder

7.0 read counter is reported.
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NOTICE TO USERS

Z-WORLD PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE-
SUPPORT DEVICES OR SYSTEMS UNLESS A SPECIFIC WRITTEN AGREEMENT REGARDING
SUCH INTENDED USE IS ENTERED INTO BETWEEN THE CUSTOMER AND Z-WORLD PRIOR
TO USE. Life-support devices or systems are devices or systems intended for surgical implantation into the
body or to sustain life, and whose failure to perform, when properly used in accordance with instructions for
use provided in the labeling and user’s manual, can be reasonably expected to result in significant injury.

No complex software or hardware system is perfect. Bugs are always present in a system of any size. In
order to prevent danger to life or property, it is the responsibility of the system designer to incorporate
redundant protective mechanisms appropriate to the risk involved.

All Z-World products are 100 percent functionally tested. Additional testing may include visual quality con-
trol inspections or mechanical defects analyzer inspections. Specifications are based on characterization of
tested sample units rather than testing over temperature and voltage of each unit. Z-World products may
qualify components to operate within a range of parameters that is different from the manufacturer’s recom-
mended range. This strategy is believed to be more economical and effective. Additional testing or burn-in
of an individual unit is available by special arrangement.
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keylInit .....coooveevivieienns 95
keypadDef ........c..cevnee 97
KeyProcess ......c.cccvvrnens 96
keyScan ......cccccoevveereennn, 97
keyunget .......cccceevrvnnnns 96
LCD display
glBackLight ........c.cc..c... 79
glBlankScreen ............... 80
gIBlock ......cccccoviviiinnn, 81
glBuffLock ........cccceeueee. 87
glBuffUnlock ................. 87
gIDispONOff .......cccuee. 79
giDownl .....ccoociiiiine, 90
glFillCircle ......cc.ccocenee. 83
glFillPolygon ................. 83
glFillScreen .......cccccce... 80
glFillvVPolygon .............. 82
glFontCharAddr ............. 84
glGetBrushType ............ 88
glGetPfStep ....ccccevenen. 85
glHScroll ..o, 90
ghinit ..o, 79
glLeftl .o, 89
glPlotCircle .........ccco....... 83
glPlotDot ..., 88
glPlotLing .......ccccoeeenen. 88
glPlotPolygon ................ 82
glPlotVPolygon ............. 81
glPrintf ..o, 86
glPutChar ........cccccoeuenn. 86
glPutFont ........cccceeenees 85
gIRightl ..., 89
glSetBrushType ............. 87
glSetContrast ................. 80
glSetPfStep ....ccovvvvenne. 85
gISWap ..o, 87
glupl .o, 89
glvScroll ..o, 91
gIXFontlnit ........ccccoceee. 84
gIXPutBitmap ................ 91
gIXPutFastmap .............. 92
TextCursorLocation ....... 93
TextGotoXY .....cccceenee 93
TextPrintf ... 94
TextPutChar ..........c...... 93
TextWindowFrame ........ 92
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LCD/keypad module

ledOut ....oooveriiee, 78
LCD/keypad module LEDs 78
libraries

PACKET.LIB ................ 27
RCM3200.LIB .............. 78
RCM32xx.LIB .............. 27
RS232.LIB ....ccccecvvvnnns 27
TCP/IP v 27
readUserBlock .................. 23
sample programs ............... 29
PONG.C ..o 29
RCM3200 ......cccevvrurannns 29
TCP/IP v 29
serial communication driv-
BIS ot 27
TCP/IP drivers .......c.c...... 27
writeUserBlock ................. 23
specifications ............cceeeveune 45
bus loading .......cccccovrvennne. 50
digital 1/O buffer sourcing and
sinking limits ................ 54
dimensions .........ccccceceeene. 46
electrical, mechanical, and
environmental ............... 48
exclusion zone .........c.c....... 47
header footprint ................. 49
headers .......cccccoovvrieninnnnn. 49
LCD/keypad module
dimensions .........c..c....... 69
electrical .......ccccoovvennne. 70
header footprint ............. 70
mechanical ...........c........ 70
relative pin 1 locations .. 70
temperature .................... 70
physical mounting ............. 49
Prototyping Board ............. 62
Rabbit 3000 DC characteris-
HICS v 53
Rabbit 3000 timing dia-
gram ..ooceeeeeeeee e 51
relative pin 1 locations ...... 49

spectrum spreader ................. 52
subsystems

digital inputs and outputs .. 12
switching modes .........c......... 21
T
TCP/IP primer ... 33
technical support .........cc.cc..... 10
U
USB/serial port converter ....... 7
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SCHEMATICS

090-0152 RCM3200 Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0152.pdf

090-0137 Prototyping Board Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0137.pdf

090-0156 LCD/Keypad Module Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0156.pdf

090-0128 Programming Cable Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0128.pdf

The schematics included with the printed manual were the latest revisions available at the
time the manual was last revised. The online versions of the manual contain links to the
latest revised schematic on the Web site. You may also use the URL information provided
above to access the latest schematics directly.
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